——

TRACPHONE

\J

TracPhone FleetBroadbhand
FB250 & FB500

TracPhone FB250 & FBs00 USer’s Guide



TracPhone FB250 & FB500

User’s Guide

The KVH® Industries’ TracPhone® FB250/FB500 system, manufactured by
Thrane & Thrane, delivers high-speed data and voice communications via
satellite through Inmarsat’s Broadband Global Area Network (BGAN). This
user’s guide provides all of the information you need to operate, set up, and
troubleshoot the system. For detailed installation information, please refer to
the Installation Guide.
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Product Information

SIM card #

Antenna serial #

Terminal serial #

Before installing the TracPhone,
write down the following numbers:

Please direct technical questions to:

North/South America, Australia: Europe, Middle East, Asia:
KVH Industries, Inc. KVH Europe A/S
50 Enterprise Center Kokkedal Industripark 2B
Middletown, RI 02842-5279 USA 2980 Kokkedal, Denmark
Tel: +1 401 847-3327 Tel: +45 45 160 180
Fax: +1 401 845-8133 Fax: +45 45 160 181
E-mail: techs@kvh.com E-mail: support@kvh.dk
Internet: www.kvh.com Internet: www.kvh.com

If you have any comments regarding this manual, please e-mail them to
manuals@kvh.com. Your input is greatly appreciated!

LTI KVH Part # 34-125645-D KVHI"
: 58001 P © 2008, KVH Industries, Inc., All rights reserved. NASDAQ
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Trademark Information
TracPhone, KVH, and the unique light-colored dome with contrasting
baseplate are registered trademarks of KVH Industries.

Thrane & Thrane is a registered trademark of Thrane & Thrane A/S in the
European Union and the United States.

Windows and Outlook are registered trademarks of Microsoft Corporation in
the United States and other countries.

Inmarsat is a registered trademark of International Maritime Satellite
Organisation (IMSO) and is licensed by IMSO to Inmarsat Limited and
Inmarsat Ventures plc.

Inmarsat’s product names are trademarks or registered trademarks of
Inmarsat.

All other trademarks are the property of their respective owners.

Disclaimer

Every effort has been made to ensure the correctness and completeness of the
material in this document. No company shall be liable for errors contained
herein. The information in this document is subject to change without notice.
No warranty of any kind is made with regard to this material, including, but
not limited to, the implied warranties of merchantability and fitness for a
particular purpose.



Safety summary

The following general safety precautions must be observed during all
phases of operation, service and repair of this equipment. Failure to comply
with these precautions or with specific warnings elsewhere in this manual
violates safety standards of design, manufacture and intended use of the
equipment. KVH Industries assumes no liability for the customer's failure to
comply with these requirements.

Observe marked areas

Under extreme heat conditions do not touch

areas of the terminal or antenna that are

marked with this symbol, as it may result in SSS
injury.

Microwave radiation hazards
During transmission the antenna in this system radiates Microwave
Power.This radiation may be hazardous to humans close to the antenna.
During transmission, make sure that nobody gets closer than the
recommended minimum safety distance.

On the TracPhone FB500, the minimum safety
distance to the antenna panel on the focal line
is 1.3 m, based on a radiation level of 10 W/m2.
The radiation level is 100 W/m2 at a distance of
0.4 m from the antenna panel. Refer to the
drawing on the next page.

(R
WARNING

MICROWAVE RADIATION
MINIMUM SAFE DISTANCE

1.3 METRES

On the TracPhone FB250, the minimum safety
distance to the antenna panel on the focal line
is 0.6 m, based on a radiation level of 10 W/m2.
The radiation level is 100 W/m2 at a distance of
0.2 m from the antenna panel. Refer to the
drawing on the next page.

(R
WARNING

MICROWAVE RADIATION
MINIMUM SAFE DISTANGE

0.6 METRES
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AT,

MICROWAVE RADIATION
No personnel within safety distance

Safety distance:
FB500:
1.3 m, 10 W/m?
/’ (0.4 m, 100 W/m?)
; FB250:

6m, 10 W/m?
(0.2 m, 100 W/m?)

\

25¢ for FB500
- 60° for FB250

Distance to other equipment

Do not move the antenna closer to radars than the minimum safe distance
specified in the installation manual - it may cause damage to the antenna.
The equipment must be installed with the following minimum safe distances
to magnetic steering compass:

TracPhone terminal: min. 0.3 m.
TracPhone FB500 antenna: min. 1.0 m
TracPhone FB250 antenna: min. 1.1 m

Service

User access to the interior of the terminal is prohibited. Only a technician
authorized by KVH Industries may perform service - failure to comply with
this rule will void the warranty. Access to the interior of the antenna is
allowed, but only for replacement of certain modules - as described in the
Installation manual. General service may only be performed by a technician
authorized by KVH Industries.

Do not service or adjust alone
Do not attempt internal service or adjustments unless another person,
capable of rendering first aid resuscitation, is present.




Grounding, cables and connections

To minimize shock hazard, the equipment chassis and cabinet must be
connected to an electrical ground. Both terminal and antenna must be
grounded to the vehicle. For further grounding information refer to the
Installation manual.

Do not extend the cables beyond the lengths specified for the equipment.
The cable between the terminal and antenna can be extended if it complies
with the specified data concerning cable losses etc.

All cables for the TracPhone system are shielded and should not be affected
by magnetic fields. However, try to avoid running cables parallel to AC
wiring as it might cause malfunction of the equipment.

Power supply

The voltage range is 10.5 - 32V DC; 14 A - 5.5 A. It is recommended that the
voltage is provided by the 24 V DC bus on the ship. Be aware of high start-up
peak current: 20 A@24 V, 5 ms.

If a 24 V DC power bus is not available, an external 115/230 VAC to 24 V DC
power supply can be used.

Do not operate in an explosive atmosphere

Do not operate the equipment in the presence of flammable gases or fumes.
Operation of any electrical equipment in such an environment constitutes a
definite safety hazard.

Keep away from live circuits

Operating personnel must not remove equipment covers. Component
replacement and internal adjustment must be made by qualified
maintenance personnel. Do not replace components with the power cable
connected. Under certain conditions, dangerous voltages may exist even
with the power cable removed. To avoid injuries, always disconnect power
and discharge circuits before touching them.

Failure to comply with the rules above will void the warranty!




About the manual

Intended readers

This manualis a user manual for the TracPhone FB500 system and
the TracPhone FB250 system. The readers of the manual include
anyone who is using or intends to use one of these two systems.
No specific skills are required to operate the TracPhone system.
However, it is important that you observe all safety requirements
listed in the beginning of this manual, and operate the system
according to the guidelines in this manual.

Manual overview

Note that this manual does not cover installation nor does it cover
how to use the IP handset that comes with the system. For
information on installation refer to the installation manual and for
information on the IP handset refer to the user manual for the IP
handset. Part numbers for both manuals are listed in the next
section.

This manual has the following chapters:

e Introduction contains an overview of the BGAN services and a
brief description of the system.

* Getting started explains how to insert SIM card and start up
the unit. It also contains a short guide to making the first call.

*  Operating the system explains how to use the system.

» Using the web interface explains how to use the built-in web
interface of the terminal, and describes the available menus
and settings, including advanced setup of interfaces.

* Troubleshooting contains a short troubleshooting guide and
explains how to update software. It also describes the
functions of the light indicators and the Reset button, and
explains the event messages that may show in the web
interface. Further, it gives information on where to get help if
needed.
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This manual may not always reflect the latest software
functionality of your terminal. To obtain the latest version of the
manual, please visit www.kvh.com and download the latest
version from the FB250 or FB500 product page.

Related documents

The below list shows the documents related to this manual and to
the TracPhone FB500 and TracPhone FB250 system.

Title and description Document
number

TracPhone FB250 & FB500 34-125646

Installation Guide

Explains how to install the TracPhone terminal,

the TracPhone FB500 antenna and the

TracPhone FB250 antenna.

TracPhone FB250 & FB500 54-0554

Quick Reference Guide

A short guide to the most important functions

of the TracPhone systems.

TracPhone IP Handset User’s Guide 34-126059

Explains the features and functions of the IP

handset. The IP handset works as a standard IP

handset, but also serves as a user interface for

the TracPhone systems.
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Typography

In this manual, typography is used as indicated below:
Bold is used for the following purposes:

* To emphasize words.
Example: “Do not touch the antenna”.

e Toindicate what the user should select in the user interface.
Example: “Select SETTINGS > LAN”.

Italic is used to emphasize the paragraph title in cross-references.

Example: “For further information, see Connecting Cables on
page...”.
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Introduction
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Welcome

Congratulations on the purchase of your TracPhone system!

TracPhone FB500 and TracPhone FB250 are maritime broadband systems,
providing simultaneous high-speed data and voice communication via
satellite through the Broadband Global Area Network (BGAN).
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Chapter 1: Introduction

Applications include:

Internet browsing

E-mail

Phone and fax services

Large file transfers

Video conferencing and Streaming

VPN (Virtual Private Network) access to corporate servers

In this chapter

This chapter introduces the TracPhone FB500 system and the
TracPhone FB250 system, and gives an overview of the physical units and
their features and functions.

It also gives an overview of the BGAN system and services.

In this chapter
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Features and interfaces

The TracPhone system offers the following features and interfaces:

B Simultaneous voice and data communication over BGAN
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®  Full duplex, single or multi-user, up to:
TracPhone FB500: 432 kbps
TracPhone FB250: 284 kbps

B Support for streaming IP at:
TracPhone FB500: 32, 64, 128, 256 kbps
TracPhone FB250: 32, 64, 128 kbps

m ISDN service, only TracPhone FB500: 64 kbps
® Voice: Standard Voice (4.0 kbps) or 3.1 kHz Audio

B 4 LAN (Local Area Network) ports with Power over Ethernet (PoE) for
computers, e-hubs, IP handsets etc.

B 2 Standard Phone/Fax ports for standard phones, fax machines or analog
modems

B 1Euro ISDN port for ISDN phones or, for TracPhone FB500 only: G4 fax or
ISDN modem

1L-Band output for connecting a broadcast receiver for maritime data
1 multi-purpose I/0 connector with 5 configurable inputs/outputs

1 SIM slot for your BGAN SIM card

Integral DHCP/NAT router

Built-in web interface allowing you to manage your phone book,
messages and calls, and customize the terminal to your specific needs

Input power: 10.5-32V DC (14 A - 5.5 A)
B CE certified

Features and interfaces 3
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Main units

TracPhone FB500/ TracPhone FB250

The main difference between the TracPhone FB500 system and the
TracPhone FB250 system lies in the antenna.

* TracPhone FB500 uses an FB500 antenna, which is a maritime BGAN Class
8 antenna.
This antenna is larger and provides more bandwidth than the antenna
used for the TracPhone FB250 system.

* TracPhone FB250 uses an FB250 antenna, which is a medium size,
maritime BGAN Class 9 antenna.

The TracPhone FB500 system and the TracPhone FB250 system basically use
the same type of terminal, except that the TracPhone FB500 offers a few more
features than the TracPhone FB250. See Features and interfaces on page 3.

Units overview

The TracPhone FB500 system includes the following main units:
* TracPhone FB500 antenna

* TracPhone terminal

* TracPhone FleetBroadband IP handset with cradle

The TracPhone FB250 system includes the following main units:
* TracPhone FB250 antenna

* TracPhone terminal

* TracPhone FleetBroadband IP handset with cradle

4 Main units
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TracPhone antennas

TracPhone FB500 antenna

The TracPhone FB500 system uses the FB500 antenna, which is a maritime
BGAN antenna. The antenna contains all functions for satellite tracking,
including a GPS system. A single coaxial cable carries all RF communication,
supply voltage and modem communication between the antenna and the
terminal.

For information on how to install the antenna, refer to the installation manual.
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This antenna is larger and provides more bandwidth than the antenna used
for the TracPhone FB250 system.

Main units 5
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Chapter 1: Introduction

TracPhone FB250 antenna

The TracPhone FB250 system uses the FB250 antenna, which is a medium
size, maritime BGAN phased array antenna.

For information on how to install the antenna, refer to the installation manual.
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TracPhone terminal

Overview
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Whether you have purchased a TracPhone FB500 system or a
TracPhone FB250 system, the terminal is basically the same. For this reason
this section covers both systems.

The TracPhone terminal is the controlling unit in the TracPhone system. It
contains all user interfaces and LED indicators and stores configuration data.
For information on how to install the terminal, refer to the installation manual.

Tools for setup and daily use

The IP handset can be used for displaying status and for entering the PIN code
for the terminal. The IP handset connects to the LAN interface of the terminal.
For information on how to use the handset menus, see the user manual for the
IP handset.

The built-in web interface is used for easy configuration and daily use. The
web interface is accessed from a computer connected to the terminal, using an
Internet browser. No installation of software is needed.

For further information on the web interface, see Chapter &4, Using the web
interface.

Main units 7
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SIM card

The terminal has a SIM slot (Subscriber Identity Module) located in the
connector panel behind a small cover plate.

The terminal requires a dedicated FleetBroadband SIM card, which is acquired
from your Airtime Provider.

The system requires a SIM card to go online and to access the settings of the
terminal. However, using the web interface you can view the Dashboard and
upload software without inserting a SIM card. Upload of software without a
SIM card requires an Administrator user name and password.

8 Main units
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IP handset and cradle

IP handset

Introduction

The IP handset communicates using Internet
protocols. The handset is not strictly
dedicated to the TracPhone system, but can
also be used in a public network as a =
standard IP telephone. féi Coly

When the IP handset is used with the
terminal, it communicates using Internet
protocol between the handset and the
terminal. However, on the BGAN network
side of the terminal, calls are transmitted as
circuit switched calls.

The IP handset is powered directly from the
LAN interface using Power over Ethernet
(PoE).

hrane & Thrane

When connected to the terminal the IP 04:01°m -
handset provides a dedicated BGAN menu

with a subset of the terminal configuration .
options.
Call | Contacts Status
For more information on the functions of the
IP handset, refer to the user manual for the D[E@ % Q

IP handset. Network  Settings

&8

BGAN

Main units 9
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IP cradle

The IP cradle serves as a holder for the IP handset.

The cradle connects to the coil cord from the handset and, using an Ethernet
cable, to the terminal.

10 Main units
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The Inmarsat BGAN system

What is BGAN?
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The Broadband Global Area Network (BGAN) is a mobile satellite service that
offers high-speed data up to 492 kbps and voice telephony. BGAN enables
users to access e-mail, corporate networks and the Internet, transfer files and
make telephone calls.

The Inmarsat FleetBroadband service

FleetBroadband is a maritime communications service offered in the BGAN
system. Based on 3G standards, FleetBroadband provides cost-effective
broadband data and voice simultaneously.

The Inmarsat BGAN system 1
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Coverage

The Inmarsat BGAN services are based on geostationary satellites situated
above the equator. Each satellite covers a certain area (footprint). The
coverage map below shows the footprints of the BGAN system.

. I-4 satellite F1

7 L satellite F2

I-4 satellite F3

(Launch planned
for 2008)

m The map depicts Inmarsat's expectations of coverage, but does not
represent a guarantee of service. The availability of service at the
edge of coverage areas fluctuates depending on various conditions.

The launch of the F3 satellite (POR) is planned for 2008.

m Certain FleetBroadband services are not available in areas with low
elevation. For further information, see Limitations on page 16.

12 The Inmarsat BGAN system
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Overview of the BGAN FleetBroadband system

A complete BGAN FleetBroadband system may include the TracPhone terminal
with connected peripherals, a TracPhone FB500 antenna or a

TracPhone FB250 antenna, the BGAN satellite, and the Satellite Access Station
(SAS). The satellites are the connection between your terminal and the SAS,
which is the gateway to the worldwide networks (Internet, telephone network,
cellular network, etc.).
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Packet Switched Network

f S .—l

IP Router

TracPhone FB250

antenna
Satellite Access Station

! SAS)
TracPhone FB500 \

250)

——_
TRACPHONE
—

TRE@NE antenna
i
Switch Standard voice
" and ISDN
TracPhone : f .
FlootBroadband Circuit Switched Network
terminal

The Inmarsat BGAN system 13



Chapter 1: Introduction

The BGAN services

Supported services

The services currently supported by BGAN comprise:

e A Packet Switched connection to the Internet
* A Circuit Switched (Dialed) connection for voice, fax or data

+ Short Messaging Service (SMS)

Packet data service

The BGAN network supports different classes of data connection to the
Internet.

» Using a Standard data connection several users can share the data
connection simultaneously. This type of connection is ideal for e-mail, file
transfer, and Internet and intranet access. The user pays for the amount of
data sent and received.

* Using a Streaming data connection you get an exclusive high-priority
connection ensuring seamless transfer of data. This type of connection is
ideal for time critical applications like live video over IP. The user pays for
the duration of the connection (per minute charge).

m The BGAN system supports maximum 11 concurrent PS connections
at a time per TracPhone system.

14 The Inmarsat BGAN system
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Circuit switched (dialed) service

The following types of circuit switched connection are available:

» Standard Voice. A low-tariff connection for voice only. The voice signal is
compressed to 4.0 kbps, which reduces the bandwidth use and
consequently the tariff.
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* 3.1kHz Audio. A high quality connection which can be used for Premium
Voice, G3 fax or analog modems. The signal is uncompressed 3.1 kHz
audio, which allows for optimum voice quality.

+ ISDN. A high quality connection which can be used for voice (3.1 kHz
Audio), G4 fax or 64 kbps UDI/RDI data.

m The BGAN system only supports one CS call at a time per TracPhone
system.

SMS service

The BGAN system provides a Short Messaging Service (SMS) for sending and
receiving SMS messages.

Supplementary services

The BGAN system also provides the following supplementary services:

* Callhold

* Call waiting

* Call forwarding
*  Voice mail

* Call barring

The Inmarsat BGAN system 15
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Limitations

SIM lock

The supplier may SIM lock the terminal to a specific provider. For further
information, contact your supplier.

Limitations in available services

The services available depend on your airtime subscription. Your SIM card

may not allow for all the services described in this manual.

Further, for FleetBroadband Class 9 (TracPhone FB250), the following

limitations apply:

Service Elevation <15 | 15 < Elevation <20 | Elevation > 20
3.1kHz Audio Not supported | Not supported Supported
for voice and
fax
ISDN Not supported | Not supported Not supported
Standard IP Up to 284 kbps | Up to 284 kbps Up to 284 kbps
Streaming 32, 64 kbps 32, 64, 128 kbps 32, 64, 128 kbps

For FleetBroadband Class 8 (TracPhone FB500), Streaming 256 kbps can only
be guaranteed in elevations > 15°.

16
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Matrix of services and interfaces

The following table shows which services can be accessed from which
interfaces on the terminal, and which types of equipment can be used.

Interface on the terminal
Service
Phone/Fax LAN (PoE) ISDN
Analog IP handset ISDN telephone
telephone
3.1kHz . .
Audio G3 Fax machine G3 Fax machine
-]
m .
S Computer with
s analog modem
w
E Standard | Analog IP handset ISDN telephone
g Voice telephone
Data, UDI G4 fax machine
or I'RDI or computer with
ISDN modem
k] Data Computer
ﬁ multi-user
.E
< Data Computer
< single-
(o]
o user
IP handset or
SMs computer with
web interface

Matrix of services and interfaces
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What’s next?

This chapter has provided an overview of the BGAN system and of the
TracPhone system.

The next chapters will go into more detail about how to set up and use your
system. The following chapter, Getting started, explains how to start up the
system.

18 What'’s next?
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Getting started

In this chapter

This chapter describes how to start up the system and make the first call or
data session.
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For information on how to install the system, insert SIM card and connect
cables, refer to the installation manual for the TracPhone FB500 and
TracPhone FB250 systems.

Before you start

Operation at high temperatures

In very high ambient temperatures, do not touch areas of &

the terminal that are marked with this symbol.

If the terminal is installed in a location where the ambient temperature may
rise above 50°C, we recommend placing the terminal where unintentional

contact is avoided. Note that the maximum allowed ambient temperature is
55° C.

If the maximum ambient temperature does not exceed 50°C, the terminal can
be placed in a public area.

For further information on installation, refer to the installation manual for the
TracPhone systems.

19
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Connector panel

The drawing below shows the connector panel of the terminal.

Power
Reset button  SIM slot DCinput switch

SIM-Card 1

L-Band Antenna
—

Phone/Fax

L-Band Antenna Phone/Fax1 Phone/Fax2 ISDN 4 x LAN w.PoE 1/0 Grounding stud

For information on how to connect to each interface, refer to the installation
manual for the TracPhone FB500 and TracPhone FB250 systems.

20 Before you start
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Starting up the terminal

SIM card

Note that the TracPhone terminal requires a SIM card dedicated to
FleetBroadband. The terminal can only access the BGAN network when the
right type of SIM card is installed. For information on how to insert the SIM

card, refer to the installation manual.
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Switching on the terminal

Using the Power switch

To switch on the terminal, use the Power switch in the connector panel. It
normally takes one or two seconds for the terminal to switch on.

L-Band Antenna

&

Output ™,

Using the ignition system

Normally the ignition function is not used in maritime installations. Instead
you may want to use the remote on/off function described in the next section.

If you have connected the ignition system of your vessel to the I/0 connector,
you may leave the power switch in the “on” position and the terminal will
switch on/off when you start/stop the engine of your vessel. When the engine
is stopped the terminal is in standby mode, meaning that only the primary
parts of the system are kept alive. The standby current is max. 15 mA when the
ignition is off. For information on how to connect to the I/0 connector, refer to
the installation manual for the TracPhone FB500 system.

You must set up the ignition function in the web interface. For further
information, see Configuring the I/0 interface on page 110.

Using a remote on/off switch

If a switch is connected to the remote on/off pins in the DC connector, you may
leave the power switch in the “on” position and use the remote switch to turn
the terminal on and off. When the remote switch is off, the terminal is off.
However, if you leave the power switch on the terminalin the “on” position,
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you can always switch the terminal back on with the remote switch. The
standby current when the remote switch is off is max. 2 mA. For further
information on the remote on/off function, refer to the installation manual for
the TracPhone systems.

Power up completed

When the terminal is switched on, the Power indicator in the LED panel of the
terminal lights green.
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Power Terminal Antenna Message LAN1 LAN2 LAN3 LAN4

Activity I I .

® Link/Speed Il NN NN

PoE I I

You can now access the terminal settings, but the terminal is not ready for
making calls or running data sessions until the system is registered on the
BGAN network. This normally requires that you enter a SIM PIN. For further
information, see Entering the SIM PIN for the terminal on page 26 and
Registering on the BGAN network on page 30.

To switch off the terminal tip the Power switch back. It takes 5 to 10 seconds to
power down the terminal. Alternatively use the ignition or remote on/off
function described above.
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Connecting the IP handset

Power supply

The IP handset is powered from the LAN interface, using Power over Ethernet.

Starting up the IP handset

The following procedure is for the TracPhone FleetBroadband IP handset. The
procedure may be different for another type of IP handset.

m The first handset that is connected to the LAN interface on the
terminal is automatically registered in the terminal and assigned the
local number 0501 and password 0501. For information on how to
connect additional handsets, see Connecting a new IP handset on
page 105.

Do as follows:

1. Connectthe IP handset to one of the LAN (PoE) connectors on the terminal
as described in the user manual for the handset.

The handset starts up automatically.

2. Ifyour SIM card requires a PIN and the PIN has not yet been entered in
the terminal, you can enter the PIN from the BGAN menu of the IP
handset.

To enter the PIN, select BGAN > Enter PIN from the handset menu system.
Note that this menu item is only available if the terminal is waiting for a
PIN. Then type in the Administrator user name and password followed by
the PIN for the terminal.

For further information on the IP handset, refer to the user manual for the
handset.
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Connecting a computer

Before connecting to the LAN interface

For the LAN interface to work without any further setup, the connected
computer must be set up to obtain an IP address and a DNS server address

automatically.
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A Important Notice About Your Data Connection

To prevent inadvertent airtime usage, the user must disconnect the data
connection when not in use. If the data connection is not properly
disconnected, the computer may dial out on its own, which could result in an
unintended airtime charge. KVH accepts no responsibility if this occurs. It is
the vessel owner's responsibility to ensure that the TracPhone system is
correctly interfaced with the vessel's computer(s).

Connecting a computer to the LAN interface

Do as follows:

1. Power up your computer.

2. Connect your LAN cable between the network connector on your computer
and one of the LAN connectors on the terminal.

3. When the computer and the terminal are ready, check the connection e.g.
by accessing the built-in web interface of the terminal with your browser.
For further information, see Accessing the web interface on page 60.

You may have to disable the Proxy server settings in your browser. For
further information, see Browser settings on page 58.

For information on how to configure the LAN interface on the terminal, see
Configuring the LAN interface on page 87.
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Entering the SIM PIN for the terminal

Overview

Depending on your SIM card, you may have to enter a SIM PIN to use the
system. You can enter the PIN using a standard phone or ISDN phone, the IP
handset or the web interface.

For information on how to connect the IP handset or computer you are going
to use, see Connecting a computer to the LAN interface on page 25 or
Connecting the IP handset on page 24.

Entering the PIN using a phone or IP handset

To enter the PIN

If you have a phone connected to the terminal, you can use it to enter the PIN
at start up.

Do as follows:

* For an analog or ISDN phone:
Pick up the phone. When the terminal is waiting for a PIN, you will hear 2
beeps - pause - 2 beeps - etc.
Dial <PIN> followed by #.
When you hear a “busy” tone or a dialing tone, the PIN has been accepted
and you can hang up or dial a number.

* For an IP handset:
Select the BGAN menu, select Enter PIN and enter the user name and
password for the terminal. Then enter the PIN for the terminal.
Note that the menu item “Enter PIN” is only available if the terminal is
waiting for a PIN.
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Wrong PIN

Analog phone or ISDN phone: If, instead of the busy tone or dialing tone, you
continue to hear 2 beeps - pause - 2 beeps - etc., it means the PIN was not
accepted. Check that you have the correct PIN and try again.

If a wrong PIN has been entered three times, you will hear 3 beeps - pause - 3
beeps - etc. This means you have to enter the PUK (PIN Unblocking Key)

provided with your SIM card.
After entering the PUK, you must enter a new PIN of your own choice (4 to 8

digits long).
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Dial the following:

<PUK> * <New PIN> * <New PIN> followed by # or off-hook key.

Example: If the PUK is 87654321 and the new PIN is 1234, dial
87654321 * 1234 * 1234 followed by # or off-hook key.

If you enter 10 wrong PUKs, the SIM card will no longer be functional. Contact
your Airtime Provider for a new SIM card.

IP handset: After having entered the user name and password for the terminal
you have 3 attempts to enter the SIM PIN, before you are asked to enter the
PUK (Pin Unblocking Key). The PUK is supplied with the SIM card for your
terminal.

Enter the PUK followed by a new PIN of your own choice. The PIN must be
from & to 8 digits long.

If you enter a wrong PUK 10 times, the SIM card will no longer be functional,
and you have to contact your Airtime Provider for a new SIM card.
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Entering the PIN using the web interface

To enter the PIN

Do as follows:

1. On a computer connected to the terminal, open your browser and enter
the IP address of the terminal. Refer to Using the web interface on page 57.

The default IP address is 192.168.0.1.

If your SIM card uses a PIN and the PIN has not yet been entered, the web

interface will open on the PIN page.

Thrane & Thrane
SIGNAL: (000000
Please enter PIN
DASHBODARD P l—ﬂl
ADMINISTRATION
q | _’l_I
|&] Dore ’_I_I_I_’_ £ Internet 7

2. Typein the PIN and click OK.

When the PIN is accepted, the web interface opens the Dashboard and is
ready for use. If the PIN is not accepted, see the next section Wrong PIN.
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Wrong PIN

You have 3 attempts to enter the PIN in the web interface, before you are
asked to enter the PUK (Pin Unblocking Key). The PUK is supplied with your

SIM card.
Enter the PUK followed by a new PIN of your own choice. The PIN must be

from & to 8 digits long.

If you enter a wrong PUK 10 times, the SIM card will no longer be functional,
and you have to contact your Airtime Provider for a new SIM card.
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Registering on the BGAN network

Registration procedure

When the SIM PIN is accepted by the terminal, the TracPhone system starts the
registration procedure on the BGAN network.

m We recommend keeping the vessel on a steady course while the
antenna is performing a sky scan. If the vessel is turning during sky
scan, it increases the total duration of the sky scan process.

You can monitor the registration procedure by looking at the Antenna and
Terminal indicators in the LED panel of the terminal.

vy

Power Terminal Antenna Message LAN1 LAN2 LAN3 LAN4

Activity I NN

® Link/Speed I HENN HEEN BN

PoE N I

Note that the registration procedure may take several minutes. The table on
the next page shows the normal sequence.
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LED indications during the registration procedure

This table shows how the startup procedure is signaled with the light
indicators. If an error occurs, the indicators will light yellow or red, depending
on the severity of the error.

Status Antenna indicator Terminal indicator

The antenna is starting up | Flashing slowly green
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The antenna is Flashing rapidly green
performing a sky scan

The terminal is Flashing green
registering on the

network

The antenna is tracking. Steady green

The system is registered Steady green Steady green

and ready for use.

For further information on the indicators, see Light indicators on page 163.
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Making the first call

Introduction

When the Antenna and Terminal indicators in the LED panel on the terminal
both light steady green, you are ready to make or receive the first call.

The following sections provide a short guide to making calls. For more
detailed information, see Making or receiving a phone call on page 42.

Making a call from the terminal

To make a call from a phone or handset connected to the terminal, dial
00 <country code> <phone number> followed by # or off-hook key.

Example: To call the number +45 39558800 from an analog phone,
dial 00 &5 39558800 #

Making a call to the terminal

m By default all handsets connected to the terminal will ring on
incoming calls. If you have connected a fax, set the incoming call
type on that Phone/Fax interface to 3.1 kHz Audio to avoid that the
fax rings and answers an incoming Standard call. For further
information, see Selecting the call type on page 39.

To make a call to a phone connected to the terminal, dial
+ <Mobile number>

* +is the prefix used in front of the country code for international calls.
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*  Mobile number: The mobile number of the terminal you are calling. The
first part of the number is always 870, which is the “country code” for the

BGAN system.

m There are two Voice numbers, one for 3.1 kHz Audio and one for
Standard Voice.

Example: If you are calling from Denmark and the mobile number for 3.1 kHz
Audio is 870782105234 on your terminal, and you want to make a
call to the terminal using 3.1 kHz Audio, dial 00 870 782105234
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If the mobile numbers are listed in the web interface, you can look them up by
selecting PHONE BOOK > Mobile numbers.

If the numbers are not listed, refer to your airtime subscription. We
recommend using the web interface to save the mobile numbers for future
reference. See Viewing and editing the mobile numbers on page 75.

Making a call from one terminal to another

To make a call from one terminal to another,
dial 00 <Mobile number>.

What’s next?

After reading this chapter you should be able to start up the terminal and
make a simple data or voice connection.

The next chapters provide more information on the user interfaces and the
setup of the terminal. The following chapter, Operating the system, explains
how to use the system.
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Operating the system

In this chapter

This chapter describes how to use the TracPhone systems.

It does not describe advanced configuration of interfaces. For this type of
information, refer to the “Configuring...” sections for the interfaces in Chapter
4, Using the web interface.

General

Operating the system

Tools for setup and use

Overview

You can use the IP handset for viewing status, using the phone book of the
terminal and for entering the PIN, but for enhanced use and for configuration
of interfaces, you need to connect a computer.

With a computer and a browser, you can use the built-in web interface to set
up the terminal.
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The IP handset

When you connect the IP handset to one of the LAN (PoE) connectors on the
terminal you can use the handset display and keypad to enter the PIN or to
view the status of the terminal.

The IP handset includes the following items for the terminal:

» Viewing (/No (signal strength) and status (“Ready”, “Registering” etc.) for
the TracPhone system.

* Viewing the IP address and software version of the terminal.
* Viewing the IP handset settings from the terminal.
* Entering the PIN and PUK for the terminal.

* Inclusion of the terminal phone book (not editable) in the IP handset
Contacts.

For further information on the IP handset, see the user manual for the IP
handset.

The web interface of the terminal

The web interface is a built-in web server for setting up and controlling the
terminal, using a connected computer with a browser. No installation of
software is required.

With the web interface you can access the same settings as with the IP
handset, and additionally:

* edit the phone book

+ view information on calls to/from the terminal

» view properties of the terminal and antenna

* set up the interfaces of the terminal

* upload software

* set up user rights (requires Administrator password)

+ set up network user groups (requires Administrator password)

For information on how to use the web interface, see Using the web interface
on page 57.
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Services and interfaces

The following table shows the possible combinations of services and
interfaces, and which types of equipment can be used.

Interface on the terminal
Service
Phone/Fax LAN (PoE) ISDN
Analog IP handset ISDN telephone
telephone
3.1kHz . _
Audio? G3 Fax machine G3 Fax machine
3
S Computer with
E analog modem
(%]
‘5
.5 Standard | Analog IP handset ISDN telephone
Voice telephone
Data, UDI® G4 fax maching
or RDI or computer with
ISDN modem
E Data Computer
£ | multi-user
=
w
£ Data Computer
& | single-user
IP handset or
SMs Computer with
web interface

a. Notes for TracPhone FB250:
UDI data is not available.

In low elevations (< 20°), 3.1 kHz Audio is not available.

General
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Using a phone or fax machine

Available interfaces

Three types of voice equipment connect to the terminal:

Standard analog phone or G3 fax machine: The terminal has two phone
connectors for connecting standard analog phones or fax machines.

IP handset: The terminal has four LAN connectors with Power over Ethernet for
connecting IP handsets or other IP equipment. For information on the features
and functions of the IP handset, refer to the user manual for the handset.

ISDN phone or G& fax machine: The terminal has one ISDN connector for
connecting an ISDN phone, a modem or a fax machine. Note that only
TracPhone FB500 supports G4 fax (UDI).

Phone/Fax 1 Phone/Fax2 ISDN LAN

For information on how to connect to the interfaces, see the installation
manual for the TracPhone FB500 and TracPhone FB250 systems.
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Selecting the call type

Definition
The phone connection can use one of the following call types:

+ Standard Voice, which is a low-tariff voice connection compressed to
4.0 kbps,

* 3.1kHz Audio, which is a high quality connection used for Premium Voice,
G.3 fax or analog modem,

* UDI or RDI (only on ISDN interface), which is used for G4 fax or data.
In the web interface you can set up which type of connection to use by default

when you make or receive a call from the Phone/Fax or ISDN interface or from
an IP handset connected to the LAN interface.

When connecting a fax or a modem to the Phone/Fax interface you must use
3.1 kHz Audio.
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Example: If you always have a fax connected to the same Phone/Fax
interface you can set this interface to 3.1 kHz Audio only. This will
mean that if an incoming Standard Voice call is received, this
Phone/Fax interface will not ring.

When connecting a G4 fax or a modem to the ISDN interface in the
TracPhone FB500 system you must use UDI.

m UDI and RDI are not available with the TracPhone FB250 system, so
you cannot connect a G4 fax machine nor a modem to the ISDN
interface on the TracPhone FB250 system.

Selecting the default outgoing call type

To select the default call type for outgoing calls, do as follows:

» ISDN. Select the call type in the web interface under SETTINGS > ISDN.
For further information, see Configuring the ISDN interface on page 92.

* Phone/Fax. Select the call type for each port in the web interface under
SETTINGS > Phone/Fax.
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For further information, see Configuring the Phone/Fax interface on
page 90.

* IP handset. Select the call type for each handset in the web interface under
SETTINGS > IP Handset > Call settings. For further information, see Setting
the call types for IP handsets on page 108.

Overriding the default outgoing call type

To override the default setting for a specific outgoing call, do as follows:

¢ To use Standard Voice for the call,
dial 1* before the number.

e To use 3.1 kHz Audio for the call,
dial 2* before the number.

Example: To make a call to the number +45 39558800, forcing the
connection to use Standard Voice, dial 1* 0045 39558800 followed
by # if calling from an analog or ISDN phone, or off-hook key if
calling from an IP handset.

m This will not change the default call type, only the type used for the
ongoing call.

40
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Phone numbers for incoming 3.1 kHz Audio and Standard Voice

3.1kHz Audio and Standard Voice have separate phone numbers. This way, a
person calling a phone connected to the terminal can select whether to use
3.1kHz Audio or Standard Voice, simply by using the dedicated phone
number.

m The call type you are using must be selected in the web interface
(refer to the next section).

If the mobile numbers are listed in the web interface, you can look them up as
follows:

Connect a computer, access the web interface and select PHONE BOOK >
Mobile numbers. For further information, see Viewing and editing the mobile
numbers on page 75.

If the mobile numbers are not available in the web interface, refer to your
airtime subscription.
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m There are two Voice numbers, one for 3.1 kHz Audio and one for
Standard Voice.

For information on how to make a call to the terminal, see Making a call to the
terminal on page 44.

Selecting the incoming call type

To select which call types are accepted for an incoming call, use a computer
and the web interface.

» ISDN. Select the call type under SETTINGS > ISDN.
For further information, see Configuring the ISDN interface on page 92.

* Phone/Fax. Select the call type for each port under SETTINGS > Phone/Fax.
For further information, see Configuring the Phone/Fax interface on
page 90.

* IP handset. Select the call type for each handset in the web interface under
SETTINGS > IP Handset > Call settings. For further information, see Setting
the call types for IP handsets on page 108.
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Making or receiving a phone call

Analog phone, ISDN phone or IP handset

There are different methods for activating a call, depending on the type of
phone:

* Analog phone or ISDN phone: Dial # after the number.
* IP handset: Press the off-hook key after the number.

Making a call

First connect your phone to the relevant interface. For further information, see
the Installation Manual.

You have different options for making a call:

* Short Dial. If the number is in the phone book of the terminal, you can use
the Short Dial number, which is found in the first column of the phone
book in the web interface. See Short dial on page 73.

Simply dial 00 <Short Dial> followed by # or off-hook key.
Example: To call entry number 4 in the phone book,
dial 00& followed by # or off-hook key.
* Manual Dial. To make a call, dial
00 <country code> <phone number> followed by # or off-hook key.
Example: To call the number +45 39558800 from an analog or ISDN
phone, dial 00 &5 39558800 #
* Call from phone book or call log (only IP handset).

* Enter the phone book of the IP handset, scroll to the wanted number
and press the off-hook key, or

* press the off-hook key from the main screen to display the latest calls
in the call log. Then scroll to the wanted number and press the off-
hook key again.

Note that this is the call log of the IP handset, not of the terminal.
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If there was an error establishing the connection, refer to the Troubleshooting
Guide on page 157.

If you are using the IP handset, the handset may show an error message.
Depending on the type of error, the web interface may also show an error
message. See Viewing the Event list or the Event log on page 150.

Receiving a call

To be able to receive a call, the phone must be connected to the relevant
interface on the terminal.

By default, all devices connected to the Phone/Fax interface, the ISDN
interface or the LAN (PoE) interface will ring when one of the mobile numbers
is called. Note, however, that this depends on the call type settings. Refer to
Selecting the incoming call type on page 41.
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Call log

Information of missed calls is stored in the call log of the terminal. You can
view the call log in the web interface under CALLS. For further information,
see Viewing the lists of calls on page 77.
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Making a call to the terminal

To make a call to a phone connected to the terminal, dial

+ <Mobile number>

+is the prefix used in front of the country code for international calls.

Mobile number. The first part of the mobile number is always 870, which is
the “country code” for the BGAN system. If the mobile numbers are listed
in the web interface, you can look them up as follows:

Connect a computer, access the web interface and select PHONE BOOK >
Mobile numbers. For further information, see Viewing and editing the
mobile numbers on page 75.

If the mobile numbers are not available in the web interface, refer to your
airtime subscription.

m There are two Voice numbers, one for 3.1 kHz Audio and one for
Standard Voice.

L
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Dialing functions

Special-purpose numbers

There are a number of dialing functions available in the terminal. The
following list shows the allocated special-purpose numbers for the terminal.

Number

Function

0 * followed by # or off-hook key

Redial last called number on this interface.

00 * followed by # or off-hook key

Redial last answered call on this interface.
Note: If the last answered number is an
unlisted number, you will not be allowed to
dial back.

00 followed by one of the numbers
1-199 and # or off-hook key

Short dial phone numbers in phone book.

0300 followed by # or off-hook key

Local call broadcast to both analog phones.

0 followed by one of the numbers
301-302 and # or off-hook key

Local call to analog phone.

0400 followed by # or off-hook key

Local call broadcast to all ISDN phones.

0 followed by one of the numbers
401-402 and # or off-hook key

Local call to ISDN phone.

0500 followed by # or off-hook key

Local call broadcast to all IP handsets.

0 followed by one of the numbers
501-516 and # or off-hook key

Local call to IP handset.

0900 followed by # or off-hook key

Local call broadcast to all handsets.

Using a phone or fax machine
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Dialing prefixes

Apart from the numbers above, the terminal uses the following dialing

prefixes:

* 1* before the phone number will force the connection to use Standard
Voice.

* 2* hefore the phone number will force the connection to use 3.1 kHz
Audio.

o #31# before the phone number will hide the callers phone number to the
recipient.

*  *31# before the phone number will show the callers phone number to the
recipient where it would otherwise be hidden, e.g. because the number is
an ex-directory number.

* Risused during a call to indicate that the following key-presses should
activate a supplementary services function. The supplementary services
functions supported by the terminal are described in the subsequent
sections.

Making local phone calls

You can make local calls between various phones connected to the terminal.
Local phone numbers always start with 0.
For an overview of the numbers, see Special-purpose numbers on page 45.

To make a local call, dial
<local number> followed by # or off-hook key.

Local numbers of analog phones, ISDN phones and IP handsets are assigned
according to the table in Special-purpose numbers on page 45. Note that if
you are using local numbers for ISDN devices, the numbers must be
programmed in the devices. For further information refer to the
documentation for your ISDN device.
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Handling waiting calls

m ‘The phone must have an R key to be able to use these functions.

During a call, if a second party attempts to make contact with you, you may
hear a Call Waiting indication. The Call Waiting indication is two beeps and a
pause of 3 seconds, then two beeps again etc. If no action is taken, the waiting
callis released after a time out period.

In the web interface you can enable or disable the call waiting indication. For
further information, see Call waiting on page 100.

When you receive a Call Waiting indication, you have the following options: é
>

o

If you want to: Do as follows: =
£

Clear the current call, PressR 1 #, within the time out period. g
[=%

o

and accept the waiting call.

Hold the current call, Press R 2 #, within the time out period.
and accept the waiting call.

Ignore the waiting call. Take no action.

Reject the waiting call. Press R 0 #, within the time out period.

m ‘The BGAN system only supports one external call at a time.
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Holding a call

m ‘The phone must have an R key to be able to use these functions.

During a call, you may place the initial call on hold while another callis made.

If you want to:

Do as follows:

Place a call on hold.

PressR 2 #.

Place the existing call on
hold and establish a new
call.

Press R and dial the second phone number
followed by #.

Shuttle between the two
calls.

PressR 2 #

(irrespective of whether the second call was
acquired using Call Hold or acceptance of
Call Waiting.)

Clear the held call, if no PressR 0 #.
waiting call exists.
Clear an active call and PressR 1 #.

return to the held call.

Note that this is only possible if no waiting
call exists.

m ‘The BGAN system only supports one external call at a time.
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Transferring a call

m ‘The phone must have an R key to be able to use these functions.

When you receive a call, you can transfer this call to another phone connected
to the terminal.

To transfer the incoming call to another phone or headset, do as follows:

1. Press R4 * <local number> #.
The phone with the local number you dialed starts to ring.
2. You now have two options.

* Hang up. The phone or headset you transferred the call to continues to
ring. When the call is answered, a connection is established between
the initial caller and the new recipient.
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* Do not hang up. When the new recipient answers, you can have a
conversation before hanging up. When you hang up, the callis handed
over to the initial caller.

m ‘The BGAN system only supports one external call at a time.
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Sending or receiving a fax message

Handling delays

When sending or receiving fax messages over satellite, both fax units must be
capable of handling longer delays without timing out. Some fax machines
have an Overseas mode, which enables the unit to handle the long delays.

Sending a fax message from the terminal

m If the default setting in the web interface is not 3.1 kHz Audio, you
can dial 2 * before the number, to force the connection to use 3.1 kHz
Audio. For further information, see Overriding the default outgoing
call type on page 40.

The fax machine must be connected to the Phone/Fax interface or the ISDN
interface of the terminal. Refer to the installation manual.

3.1 kHz Audio must be used for an analog fax machine. Refer to Selecting the
default outgoing call type on page 39.

UDI must be used for an ISDN G& fax machine, Note that this is not possible in
a TracPhone FB250 system. Refer to Configuring the ISDN interface on
page 92.

To send a fax from a fax machine connected to the terminal, dial
00 <country code> <phone number> #

Example: To send a fax to the number +45 39558888,
dial 00 &5 39558888 #
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Sending a fax message to the terminal

To send a fax message to the terminal, dial
+ <Mobile number> #

* +isthe prefix used in front of the country code for international calls.

* Mobile number. The first part of the mobile number is always 870, which is
the “country code” for the BGAN system. Use the 3.1 kHz mobile number if
you are calling a G3 fax and the UDI number if you are calling an ISDN G4
fax connected to the terminal. If the mobile numbers are listed in the web
interface, you can look them up as follows:

Connect a computer, access the web interface and select PHONE BOOK >
Mobile numbers. For further information, see Viewing and editing the
mobile numbers on page 75.

If the mobile numbers are not available in the web interface, refer to your
airtime subscription.
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m There are four mobile numbers, one for 3.1 kHz Audio, one for
Standard Voice, one for UDI and one for RDI.

Receiving a fax message

An analog fax machine connected to the terminal can only receive a fax with
3.1kHz Audio. Refer to Selecting the incoming call type on page 41.

An ISDN G4 fax machine connected to the TracPhone FB500 terminal can only
receive a fax with UDL TracPhone FB250 does not support UDI and cannot be
used with a G4 fax machine.
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Using a computer

Interfaces

The terminal has four LAN connectors for connecting computers or other LAN
equipment.

For information on how to connect to the interfaces, see the installation
manual for the TracPhone FB500 and TracPhone FB250 systems.

Standard or Streaming data on LAN

Definition

The BGAN network supports different classes of data connection to the
Internet. The main classes are Standard data and Streaming data.

* Using a Standard data connection, several users can share the data
connection simultaneously. This type of connection is ideal for TCP/IP
traffic such as e-mail, file transfer, and Internet and intranet access.
The user pays for the amount of data sent and received.

» Using a Streaming data connection, you get an exclusive, high-priority
connection, ensuring seamless transfer of data. This type of connection is
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ideal for time critical applications like live video over IP.
The user pays for the duration of the connection (per minute charge).

m For optimum performance it is important that you select the right
traffic class when defining profiles for your connection.

You can set up various types of connection using the profiles and traffic flow
filters. For further information, see Using profiles on page 139 and Using traffic
flow filters on page 143.

Setting up and activating a Streaming connection

The TracPhone FB250 system supports 32, 64 and 128 kbps Streaming.
The TracPhone FB500 system supports 32, 64, 128 and 256 kbps Streaming.

w You may have difficulties establishing the fastest Streaming
connection if you are located close to the edges of the satellite beam.
256 kbps Streaming on TracPhone FB500 and 128 kbps Streaming on
TracPhone FB250 normally require an elevation angle of more than
15 degrees.
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By default, any data connection on the terminal is a Standard data connection.

If you want to set up a Streaming connection, select a Streaming profile when
setting up your network user group. See Managing LAN network users on
page 111.

To start or stop a Streaming session on the LAN interface, do as follows:

1. Access the web interface.
2. In the Dashboard, locate the field STREAMING PROFILES ON LAN.
3. Click the Start or Stop link of the relevant Streaming profile.

m If another primary profile is active you must stop it before you
can start your new profile.

m When running a Streaming session you are charged for the time
you are connected. A started Streaming session will stay active
until you stop it.
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For further information, see Using profiles on page 139 and Setting up the
network user groups on page 113.

Working with network groups

The LAN users of the TracPhone system can be organized in network user
groups with different setup and different access rights.

Users can only see and start/stop profiles configured for their own network
user group.

Using the built-in web interface with an Administrator password you can
configure the network user groups and network devices.

For further information, see Managing LAN network users on page 111.
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Using the IP handset

You can use the IP handset as user interface for the TracPhone system as well
as for making calls or sending SMS messages.

The IP handset has a dedicated menu for the TracPhone system.

For information on how to start up the IP handset, see Connecting the IP
handset on page 24.

For further information on how to use the IP handset, refer to the IP Handset
User Manual.

What’s next?

This chapter has described the basics of how to use the TracPhone system.
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The following chapter, Using the web interface, describes how to use the built-
in web interface for setting up and using the system.
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Using the web interface

In this chapter

This chapter describes how to use the web interface to operate, set up and
configure your TracPhone system.

Introduction

The web interface

What is the web interface?

The web interface is built into the terminal, and is used for operating, setting
up and configuring the system.
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You can access the web interface from a computer with a standard Internet
browser. Internet Explorer 6.0, Mozilla Firefox 1.0 and Apple Safari 2.0 were
tested successfully with the web interface. You may be able to use other
browser versions as well.

Connecting

Connect your computer to the terminal, using the LAN interface. For
information on how to connect to the LAN interface, see the installation
manual.

To access the web interface, an Internet browser must be installed on the
computer.
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Browser settings

If you are connecting your computer using the LAN interface, the Proxy server
settings in your browser must be disabled before accessing the web interface.

Most browsers support disabling of the Proxy server settings for one specific IP
address, so you can disable Proxy server settings for the web interface only, if
you wish. Consult your browser help for information.

To disable the use of a Proxy server completely, do as follows:

m The following description is for Microsoft Internet Explorer. If you
are using a different browser, the procedure may be different.

1. In Microsoft Internet Explorer, select Tools > Internet Options >
Connections > LAN Settings.

Local Area Network (LAN) Settings e

— Automatic configuration

Autornatic configuration may override manual settings, To ensure the
u=e of manual settings, disable automatic configuration.

[ Automatically detect settings

[ Use automatic configuration scripk

fddress I

~Proxy server

r Ilse a proxy server For your LAKN (These settings will not apply I:u:u
dial-up or YPMN connections),

fddress: |1IZI 1.1.8 Pork: I Advanced,, |

¥ | Bvpass prowy server For locall addresses

| (04 I Cancel |
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2. Uncheck the box labeled Use a proxy server for your LAN.
3. Click OK.
When the proxy server settings are disabled, close your browser.

You may need to change this setting back on return to your Internet
connection.
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Accessing and navigating the web interface

Accessing the web interface

To access the web interface, do as follows:

1. Connect your computer to the terminal.

2. Start up the terminal.
For further information, see Getting started on page 19.

3. Open your browser and enter the IP address of the terminal.
The standard IP address is 192.168.0.1.

m If the IP address is changed and you do not have the new address,
you can temporarily set the IP address to the default value by
pressing the Reset button next to the SIM slot in the connector panel
of the terminal. You can then access the web interface and change
the IP address.

Note that if you do not change the IP address, the default IP address
will only be valid until the terminal is powered off. Then the terminal
returns to the IP address from before the Reset button was pressed.

For further information on the Reset button, see Reset button on
page 180.

60

Introduction



Chapter 4: Using the web interface

Overview of the web interface

When the web interface opens, the title bar shows the name of the product.

m If no antenna is connected, the web interface will assume that the
system is a TracPhone FB500 system.

The web interface consists of the following sections.

Title bar Icon bar Contents section

3 Thrane & Thran ILOR 500 FleetBroadband - Microsoft Internet Explorer [ ]
| &
Adcress [{€] http:if192.168.0.1/ B

Fle Edt Yew Favorkes \Jools Help

Status
field Thrane & Thrane
\.
SIGNAL: noooooo
DASHBOARD PROPERTIES SESSIONS TOTAL
PHONE BOOK Airtime provider  Thrane & Thrane Standard voice inbound  00:19:08
Navigation MESSAGES GPS position Acquiring Standard voice outbound 00:11:35
pane CALLS Status Scanning 3.1 kHz audic inbound  09:30:00
\ SETTINGS Satellite selection Auta 3.1 kHz audio outbound  00:16:00
ADMINISTRATION Unit serial number 05744519 Standard data .00 MB
HELPDESK Software version 0101 Streaming 32 kbps 00:00:00
SITE MAP Local IP address  182.166.0.1 Streaming 64 kbps 00:00:00
IMEI number 35571200-000019-6  Streaming 128 kbps  19:08:00
MAC address 00:11:CFi01:12:B4  Streaming 256 kbps  00:00:00
Antenna FBESS (Sky scan)
ONGOING DATA SESSIONS ONGOING CALLS
(No active data sessions) (N active calls)

STREAMING PROFILES ON LAN

(Mo streaming profiles defined)

J | of

* The navigation pane holds the main menu. Clicking an item in the menu
opens a submenu in the navigation pane or a new page in the contents
section.

* The status field shows the signal strength.

* Theicon bar shows icons for new SMS messages and for active events,
when relevant. For explanations of the icons, see the next section, Icons in
the icon bar.

* The contents section shows the page selected in the navigation pane. This
section is used for viewing or changing settings, or for performing actions.
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Icons in the icon bar

The following icons may appear in the icon bar in the web interface:

Icon Explanation

DA | Anew SMS message, or information of Voice mail, has arrived.

Click the icon to see new messages or information of Voice mail.
For further information, see Receiving a message on page 82.

A An event is active.

Click the icon to see a list of active events. For explanations of the
event messages, see List of events on page 168.

Note that this icon will remain in the icon bar as long as the
event is still active.

Navigating the web interface

* To expand a menu, click the menu in the navigation pane.

* To access status and settings, click the relevant subject in the navigation
pane or click the relevanticon in the icon bar. The status or settings are
displayed in the contents section.

* To see the site map, click SITE MAP in the navigation pane. Click on items
in the site map to go directly to the relevant location.
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Entering the SIM PIN in the web interface

m You may not have to enter a SIM PIN to access the terminal. This
depends on whether or not the use of a SIM PIN is enabled on your
SIM card.

If a computer is connected when you start up the terminal, you can access the
web interface and enter the SIM PIN here.

If your SIM card requires a PIN, and the PIN has not yet been entered: When
you access the web interface, it opens on the PIN page. Until you enter the PIN
you can only upload software and view the Dashboard. Access to all other
parts of the web interface requires a PIN.

Thrane & Thrane

ADMINISTRATION

()

o

C

=

[

noooooo £
o)

Flease enter PIM qg;

DASHBOARD PIN: l— OKI _GC"
+—

(=2}

c

‘@

o

=
Al | »

Type in the PIN and click OK.

If you enter a wrong PIN 3 times you are asked for a PUK (PIN Unblocking
Key). For further information, see Wrong PIN on page 29.

If the PIN has already been entered in the terminal, or the PIN is disabled, the
web interface goes directly to the Dashboard at start-up.
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When the correct PIN is entered, the web interface opens the Dashboard and
is ready for use.

m Some parts of the web interface may be greyed out if the user
permissions are limited. For information on how to set up user
permissions, see Setting up user permissions on page 146.
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Using the Dashboard

Overview

The Dashboard is used for control and inspection of ongoing communication
and for viewing properties and status of the terminal and antenna.

Thrane & Thrane
SIGNAL: noooooo
DASHEOARD PROPERTIES SESSIONS TOTAL
PHONE BOOK Airtime provider Thrane & Thrane Standard voice inbound  00:19:08
MESSAGES GPS position Acquiring Standard woice outbound 00:11:35 I3)
CALLS Status Scanning 3.1 kHz audio inbound  09:30:00 E
=
SETTINGS Satellite selection Auto 3.1 kHz audio outbound  00:16:00 8
ADMINISTRATION Unit serial number 05744519 Standard data 8.00 MB ._E
HELPDESK Software version 01.01 Streaming 32 kbps 00:00:00 q;'.
SITE MAP Local IP address 19z.168.01 Streaming 64 kbps 00:00:00 _GC)
IMEI number 35871200-000019-5 Streaming 128 kbps 19:08:00 ;
MALC address 00:11:CF:01:12:B4 Streaming 256 kbps 00:00:00 'E
Antenna FBBSS (Sky scan) =
ONGOING DATA SESSIONS ONGOING CALLS
(Mo active data sessions) (Mo active calls)

STREAMING PROFILES ON LAN

(Mo streaming profiles defined)

Refresh

>
<

| 5
& TTL [ ews
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Properties

The PROPERTIES section of the DASHBOARD shows the following information:

Airtime provider. The name of your Airtime Provider.

GPS position. The GPS position of your TracPhone system.

@ In some cases, the BGAN network does not allow the position to
be displayed to the user. If this is the case, the display may just
show GPS acquired. This means that the GPS position is received,
but the user is not allowed to see it.

This also applies if the TracPhone is not yet registered on the
BGAN network, but the GPS position is received.

Status. The status of the terminal and antenna.
Examples of status information are: Scanning, Ready and Data active.

Satellite selection. The satellite selected for logon. For further information,
see Selecting the preferred BGAN satellite on page 131.

Unit serial number. The serial number of the terminal.
Software version. The version of the software embedded in the terminal.

Local IP address. The local IP address of the terminal. This is the IP
address used to access the terminal from a device connected to the
terminal.

IMEI number. The IMEI number (International Mobile Equipment Identity)
of the terminal. This is a unique number that identifies your terminal.

MAC address for the LAN interface in the terminal.

Antenna. The type of antenna connected to the terminal, and the status of
the antenna.
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Managing data sessions

Overview

Data sessions are displayed under PROFILES ON LAN or STREAMING PROFILES
ON LAN at the bottom of the Dashboard.

ONGOING DATA SESSIONS ONGOING CALLS
(Mo active data sessions) (Mo active calls)
STREAMING PROFILES OM LAN {Group 0}

Start Streaming 128

Refresh |

* Primary profiles are listed in the left side and secondary profiles (if any)
are listed to the right.

* Profiles that are currently active are displayed as a link with the text “Stop
<name of profile>".
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* Profiles that are ready to be activated are displayed as a link with the text
“Start <name of profile>".
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Start/stop a Streaming session on the LAN interface

m Before starting a Streaming session, make sure you have set up a
Streaming profile for your user group in the SETTINGS > LAN >
Network user groups page.

To start or stop a Streaming session, click the link with the name of your
Streaming profile under STREAMING PROFILES ON LAN.

Note that if another primary profile is active you must stop it before you can
start your new profile!

If a primary profile is already active, your new profile will not appear as a link
but as plain text. The active primary profile is displayed as a link with the text
“Stop <name of profile>”. Click this link first to stop the active profile. Then
click your new profile, which is now displayed as a link.

m If you have selected a Streaming connection as your primary
profile, the LAN interface will be running a Streaming

connection until you stop it or disconnect the interface.
However, if you select one or more secondary profiles, you can
set up your traffic flow filter so that it will only use the
Streaming profile for certain types of traffic.

For information on setup of the network user groups, see Managing LAN
network users on page 111. For information on how to set up a profile, see
Using profiles on page 139.

m You may have difficulties establishing the fastest Streaming
connection if you are located close to the edges of the satellite beam.
256 kbps Streaming on TracPhone FB500 and 128 kbps Streaming on
TracPhone FB250 normally require an elevation angle of more than
15 degrees.
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Start/stop Standard data on the LAN interface

By default, Standard data is always activated on the terminal. If you only want
Standard data to be activated when you have specifically enabled it, you can
disable automatic activation using the SETTINGS > LAN > Network user groups

page.

When automatic activation is disabled in the Network user groups page, you
can manually start/stop your Standard data profile from the Dashboard by
clicking Start <name of profile> or Stop <name of profile> under PROFILES ON
LAN at the bottom of the page.

m If another primary profile is active you must stop it before you can
start your new profile.

OMGOING DATA SESSIONS ONMGOING CALLS
(Mo active data sessions) (Mo active calls)

PROFILES ON LAMN {Default group)

Start Standard

Refrash |
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If a primary profile is already active, your new profile will not appear as a link
but as plain text. The active primary profile is displayed as a link with the text
“Stop <name of profile>". Click this link first to stop the active profile. Then
click your new profile, which is now displayed as a link.
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Viewing information on calls and data sessions

The following sections in the Dashboard show information on calls and data

sessions.

ONGOING CALLS is a list of calls that are currently active. The list shows the
call type and the time connected for each call.

ONGOING DATA SESSIONS is a list of data profiles that are currently active,
including the IP address that is assigned to each profile.

SESSIONS TOTAL lists the totals for each connection. The list shows the
time connected for voice and Streaming data, and MB transferred for
Standard data.

The counters show totals for connections since the counters were last cleared.

PROPERTIES
Airtime provider
GPS position
Status

Satellite selection
Unit serial number
Software version
Local IP address
IMEI number
MAC address

Antenna

Thrane & Thrane
Acquiring

Scanning

Auto

05744519

01.01

192.1658.0.1
35571200-000019-5
00:11:CFi0l:12:B4

FBBSS (Sky scan)

ONGOING DATA SESSIONS

(Mo active data sessions)

STREAMING PROFILES ON LAN

(Mo streaming profiles defined)

Refrezh |

SESSIONS TOTAL

Standard voice inbound  00:19:08

Standard voice outbound 00:11:35

3.1 kHz audio inbound

09:30:00

3.1 kHz audio outbound  00:16:00

Standard data
Streaming 32 kbps
Streaming 64 kbps
Streaming 128 kbps

Streaming 256 kbps

ONGOING CALLS

(Mo active calls)

§.00 MB

00:o0:00

00:o0:00

19:08:00

00:o0:00
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Using the phone book

General usage

Overview

In the phone book you can:

* Look up phone numbers.
* Look up short dial numbers for easy dialing from a handset.

* Modify or delete existing names and phone numbers, or enter new names
and phone numbers.
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Accessing the phone book

To access the phone book, select PHONE BOOK from the left navigation pane.

SIGNAL: uuuuuuu
DASHBOARD Entry¥ Namew Numbere Actions
PHONE BOOK 1 Mr. Jones 004539555800 Edit/Delete
Mobile numbers 2 Mrs. Smith 004539555888 Edit/Delete
MESSAGES 3 Hew
CALLS 4 Hew
SETTINGS 5 Hew
ADMINISTRATION 6 Hew
HELPDESK 7 Hew
SITE MAP 3 Hew
9 Hew
10 New
11 New
1z New
13 New
14 New
15 New
16 New
17 New
18 New
19 New  _J
20 New
Delete all entries in phone book
12345678910 —
o | _r'
=] [T T T e e 4

The phone book shows all entries with entry number, name and phone
number. Empty place holders are also included.

To sort the phone book, click the title of the column you wish to sort by. For
example, to sort by the names in the phone book alphabetically, click on Name
in the top row of the phone book.

The phone book holds 199 entries divided into subpages. To select the
subpages you want, click the relevant link at the bottom of the page.
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Short dial

The entry number in the phone book is the Short dial number. When making a
call from the terminal you can use this number instead of dialing the entire
phone number.

Simply dial 00 <short dial> followed by # or off-hook key.

Example: To call the third entry in the phone book from an analog phone,
take the phone off hook and dial 003 #.
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Editing phone book entries

Adding a new entry

To add a new entry, do as follows:

1. Inthe phone book, locate the empty entry number where you want to add
the new phone number and click New.

2. Typein the name and phone number of the new entry and click Save
entry.

The new name and number are now listed at the specified entry number in
the phone book.
Modifying an entry in the phone book
To modify an entry, do as follows:

1. In the phone book, click Edit next to the entry you want to modify.

2. Modify the name or number as wanted and click Save entry.

The name and/or number in the selected entry is now replaced with the
new information.

Deleting an entry in the phone book

To delete an entry, click Delete next to the entry you want to delete.

Deleting all entries in the phone book

To delete all the entries in the phone book, click Delete all entries in phone
book at the bottom of the PHONE BOOK page.
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Viewing and editing the mobile numbers

To view the mobile numbers

To view the mobile numbers of the terminal, select PHONE BOOK > Mobile
numbers from the left navigation pane. The mobile numbers are the phone
numbers to use when making a call to the terminal.

m These numbers are not listed at delivery. The user must enter the
numbers received from the Airtime Provider.

Thrane & Thrane
SIGNAL: [oooooo o
o
C
=
MOBILE NUMBERS FOR CURRENT SIM CARD 8
DASHBOARD fs
Standard voice B70772420567 5
PHONE BOOK 3]
3.1 kHz audio 870782105234 — g
Mobile numbers )
uDI {64 kbps) 670782105235 =
MESSAGES pt
RDI (56 kbps) 570782105236 =
CALLS o
Edit -
SETTINGS
ADMINISTRATION
HELPDESK
SITE MAP
-
4 | 3
’_l_l_,_’_ # Internet v

To enter or edit the mobile numbers

To enter or edit the mobile numbers, click Edit at the bottom of the page, type
in the numbers received from your Airtime Provider and click OK.

Using the phone book 75



Chapter 4: Using the web interface

Using the Call log

m If power to the terminal is interrupted, all information on calls since
last power up is lost. This could mean that you will be charged for

more calls than the number of calls registered in the call log.

Information on total usage

To enter the CALLS page select CALLS from the left navigation pane. The CALLS

page contains information on usage for circuit switched connections.

For an explanation of the circuit switched services, see Circuit switched

(dialed) service on page 15.
The listed information includes:

* Time connected using Standard Voice and

* time connected using 3.1 kHz Audio.

Thrane & Thrane

SIGNAL: [ooooon

TOTAL USAGE
DASHBOARD
PHONE BOOK Standard voice: 00:30:01
MESSAGES

3.1 kHz Audio: 00:10:13
CALLS

Outgoing calls
Received calls Export call log to file
Missed calls
Standard data sessions
Streaming data sessions
SETTINGS
ADMINISTRATION
HELPDESK

SITE MAP

1 |

76 Using the Call log




Chapter 4: Using the web interface

Exporting the call log
The system logs all calls and data sessions. For information on how to view the
lists of calls and data sessions, see the next section.

To export the entire call log to a file, do as follows:

1. In the CALLS page, click the link Export call log to file.
2. Browse to the location where you want to save the log.

3. Click OK.

Viewing the lists of calls

To see information on outgoing, received or missed calls or data sessions,
select one of the following lists from the left navigation pane in the CALLS

page:
* Outgoing calls shows the start time, receiving end phone number,

duration, type (Standard or 3.1 kHz Audio) and estimated charge of each
outgoing call.
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* Received calls shows the start time, calling phone number, duration and
type (Standard or 3.1 kHz Audio) of each incoming call.

* Missed calls shows the start time, calling phone number and type
(Standard or 3.1 kHz Audio) of each incoming call that was not received.

+ Standard data sessions shows the start time, bytes in, bytes out and
estimated charge of each Standard data session.

+ Streaming data sessions shows the start time, duration, type (Streaming
32, 64, 128 or 256 kbps) and estimated charge of each Streaming data
session.

Date and time is UTC time, received from the satellite.
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For information on the available types of service, see The BGAN services on
page 14.

m The estimated charge is based on your entries under
ADMINISTRATION > Call charges. KVH Industries does not take
responsibility for the correctness of this estimated charge.

You can sort each of the lists by clicking the title of the column you wish to sort
by.

If a list covers more than one page, you can click the relevant link at the
bottom of the page, to go to another page.

When there are more than 100 calls in the total list, the oldest calls are
automatically removed to make room for new calls.
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Handling SMS messages

Sending an SMS message

m If the terminal is not online when you attempt to send a
message, the message is moved to the Outbox in stead of the
Sent folder. Messages in the Outhox are not automatically sent
when the terminal goes online. For further information on the
Outbox, see the next section, Options for messages in the
Outbox.

To make sure a message has been sent, check that it has been
moved to the Sent folder.

To send an SMS message from the terminal, do as follows:

1. Click MESSAGES from the left navigation pane.
This page contains new incoming messages.

2. In the left navigation pane, click Write message.
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3. Typein the message in the Write new message field.

If the message text is too long for one SMS, the message is sent as two or
more SMS messages. The field below the message field shows the number
of SMS messages used to send the message.

Type in the phone number in the Recipient field.

Remember 00 and country code (e.g. 00 45 to call Denmark or 00 1 to call
USA).

Select whether or not you want Delivery notification for this SMS message.

If you click Yes, the Status column in the Sent folder will show the status of
your message when it has been sent.

You can set up delivery notification generally for all SMS messages. This
setting is used by default when you send a message. For further
information, see Configuring message settings on page 84.

Click Send.

The message is now sent and moved to the Sent folder.

Options for messages in the Outhox

Messages in the Outhox are messages that have not been sent, e.g. because
the terminal was not online when you attempted to send the messages.

To access the Qutbox, click MESSAGES > Outbox from the navigation pane.

You have the following options for messages in the Outbox:

When the terminal is online, click Resend next to the message you want to
send. When the Write message page opens, click Send.

The terminal now attempts to send the message again. To make sure the
message has been sent, look in the Sent folder.

m The original message remains in the Outbox. When you have
succeeded in sending the message you may want to delete it
from the Outbox.

Click Delete next to a message to delete it.

Click Delete all messages in Outbox to delete all the messages.
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Options for messages in the Sent folder

The Sent folder contains SMS messages that have been sent.
To access the Sent folder, select MESSAGES > Sent from the navigation pane.

The Status column shows the status of each message, if you have selected
Delivery notification when sending the message.

From the Sent folder you have the following options:

* Click Resend next to a message you want to send again.
When the Write message page opens, click Send.
The terminal now attempts to send the message again. To make sure the
message has been sent, look in the Sent folder. There should now be two
copies of the sent message.

* Click Forward next to a message you want to forward.
Type in the phone number of the new recipient and click Send.
The terminal now attempts to send the message to the new recipient. To
make sure the message has been sent, look in the Sent folder.

* Click Delete next to a message to delete it.

* Click Delete all sent messages to delete all the messages.
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Sending an SMS message to the terminal

You can send an SMS message to the terminal e.g. from a mobile phone,
using one of the mobile numbers for voice. Dial

+ <Mobile number>

The first part of the mobile number is always 870, which is the “country code”
for the BGAN system. If the mobile numbers are listed in the web interface,
you can look them up as follows:

Select PHONE BOOK > Mobile numbers. If the mobile numbers are not listed in
the web interface, refer to your airtime subscription.

m There are two Voice numbers, one for 3.1 kHz Audio and one for
Standard Voice.
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Receiving a message

If a message has arrived, the icon bar at the top of the web interface shows an
unopened envelope. Click the envelope to see the new message(s).

Otherwise, to see new messages click MESSAGES from the left navigation
pane.

The page shows new incoming messages.

@ The terminal does not accept more than 100 incoming messages
(including read and unread messages). If you have received 100
messages, you have to delete some of them in order to free space
for new messages. Otherwise, the new messages are rejected.

If the message is not an SMS message but information of voice mail, call your
voice mail service number to hear the voice mail.

To find your voice mail number, select MESSAGES > Message settings from the
left navigation pane and locate the Voice mail number.

Note that the voice mail number is only shown if it is available on the SIM
card. Otherwise, refer to the information included with your Airtime
subscription.
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Options for new SMS messages

To see new messages, click MESSAGES from the left navigation pane.

Besides viewing the new messages, you have a number of options for what to
do with each message:

* Click Read to move it to your Inbox containing read messages.

* Click Reply to reply to a message.
Then type in your reply and click Send.
For information on how to include the original message in your reply, see
Setting up the default message options on page 84.

*  Click Forward to forward a message to someone.
Then type in the phone number in the Recipient field and click Send.

» Ifyou want to move all the new messages, click Move all new messages to
Inbox.

m New messages cannot be deleted until they have been moved to
the Inbox.
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Options for SMS messages in the Inbox

The messages in the Inbox are the incoming messages that have been read
and moved from the list of new messages (refer to the previous section).

From the Inbox, you have the following options:

*  Click Reply to reply to a message.
Then type in your reply and click Send.
For information on how to include the original message in your reply, see
Setting up the default message options on page 84.

*  Click Forward to forward a message to someone.
Then type in the phone number in the Recipient field and click Send.

*  Click Delete to delete the message.

* Click Delete all messages in Inbox to delete all read messages in the Inbox.
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Configuring message settings

Setting up the default message options

You can set up general options for your outgoing messages. These settings
apply by default to all your outgoing messages. Note, however, that you can
change the Delivery notification setting for an individual message. For further
information, see Sending an SMS message on page 79.

Do as follows:

1. Select MESSAGES > Message settings from the left navigation pane.

SIGNAL: ooooooo
SMS service center! +870772001799 Edit
DASHBOARD
Waice mail number: +870772001899
PHONE BOOK
Include message inreply: O ves @ Na
MESSAGES
Inbox Delivery notification: Coves % no
Write message apply | cancel
Outbox
Sent
Message settings
CALLS
SETTINGS
ADMINISTRATION
HELPDESK
SITE MAP
4| | _’lJ
) [ T [ [ |4 mtemnet 7

2. If you want to include the original message when you reply, select Yes
next to Include message in reply.

3. Select whether or not you want Delivery notification for SMS messages.

If you click Yes, the Status column in the Sent folder will show the status of
your message when it has been sent.

4. Click Apply.
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Viewing or changing SMS service center number

The SMS service center number identifies the SMS service center used when
sending and receiving SMS messages. The SMS service center number is
stored on the SIM card.

* To see the SMS service center number, select
MESSAGES > Message settings from the left navigation pane.

* To change the number, click Edit next to SMS service center, change the
number and click Save. Then click Apply to apply all changes in the page.

The SMS service center number is provided from your Airtime Provider.

Viewing the Voice mail number

The Voice mail number is the number you call to hear your incoming voice
mails.

m The Voice mail number is only listed if it is available on the SIM
card. Otherwise, refer to the information included with your Airtime
subscription.

To see the Voice mail number, select
MESSAGES > Message settings from the left navigation pane. The Voice mail
number field shows the Voice mail number.
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Setting up the interfaces

The SETTINGS page (Antenna properties)

The SETTINGS page shows properties of the connected antenna and contains a
field for enabling or disabling the L-Band interface on the terminal.

To access the SETTINGS page, select SETTINGS from the left navigation pane.

Thrane & Thrane
SIGNAL: ["]l]l]uuu
DASHBOARD
PHONE BOOK
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CALLS
SETTINGS
LAN
Phone fFax

ISDN
Common

IP handsets
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Upload
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ANTENNA

Antenna bootloader version:
Antenna software version:
Antenna serial number;
L-BAND CONNECTOR

L-band connectar

Apply | cancal

1.0

1.0

15704719

 Enabls ¥ Disable
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Enabling or disabling the L-Band interface

The L-Band interface is used for connecting a broadband receiver for
reception of position data. To enable or disable the L-Band interface, do as

follows:

1. Inthe L-BAND CONNECTOR field of the SETTINGS page, select Enable or

Disable.
2. Click Apply.
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Configuring the LAN interface

Overview

The TracPhone terminal has 4 LAN connectors with PoE (Power over Ethernet).

The major part of the LAN parameters are set up in the network management
pages. For information on these settings, refer to Managing LAN network
users on page 111.

ACauﬁon! All connections to the LAN interface may be affected when
you change the settings below. This also includes your own
current connection.
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Setting up the LAN interface

Do as follows:

1. From the left navigation pane, select SETTINGS > LAN.
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MESSAGES Local IP address |192 .|168 .|0 .|1
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LAN

Port farwarding
MNetwork devices
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y
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2. At DHCP status, select Enabled (recommended), or Disabled.

+ If you select Enabled, the terminal assigns dynamic IP addresses to
devices connected to the terminal.

» Ifyou select Disabled, you need to set up a static IP address in the
connected device.

3. Type in the Local IP address and the Netmask.

The Local IP address is the IP address used for accessing the web
interface.

4. Click Apply.
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Port forwarding

Port forwarding enables you to set up a server connected to the terminal while
the terminal is in Router mode. Without port forwarding it would not be
possible to contact the server from the internet.

For information on how to set the terminal in Router mode, see Setting up the
network user groups on page 113.

The following example shows how to allow internet access to a mail server
(smtp) connected to the terminal.

The mail server in this example has the IP address 192.168.0.100.

1. Select LAN > Port forwarding in the left navigation pane.

()
()
ooonoog =
[
—
.C
DASLEIZED PORT FORWARDING ﬁ
PHONE BOOK Part forwarding @ Enabled " Disabled =
()
MESSAGES Active  Incoming port range Destination IP Destination port range =
CALLS 2 25 -[z= 152,166.0.100 25 - g‘
SETTINGS O
r o o 0.0,0.0 o o 5
LAN
Port forwarding O g e ©.0.0.0 g )
Metwork devices r ER N 0.0.0.0 |-
Metwork classification r o -|o 0.0,0.0 o o
Metwork user groups r lU—'IU— IW lU—'l—
Ph F
one/Fax r o o 0.0,0.0 o o
ISDN
r o o 0.0,0.0 o o
Common
IP handsets r B -0 0.0.0.0 B -
Discrete 1/0 r o <o 0.0.0.0 o -
Upload Apply Cancel
Satellite selection

2. Select Enabled to generally enable port forwarding.
3. Type in the Incoming port range.

4. Type in the Destination IP address, which in this example is the IP address
of the mail server: 192.168.0.100.
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5. Type in the Destination port range.
6. Repeat step 3 to step 5 to set up port forwarding to additional servers.

7. In the Active column, select which ports should have port forwarding
activated.

8. Click Apply.

You can now access the mail server from the Internet, using the external IP
address of the terminal.

Configuring the Phone/Fax interface
Do as follows:

1. Select SETTINGS > Phone/Fax from the left navigation pane.
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2. For each Phone/Fax port, set the call type for incoming and outgoing calls.

m Port 1is the connector closest to the antenna connector, and Port
2 is the connector closest to the ISDN connector.

The call types are described in more detail in Selecting the call type on
page 39.

* For Incoming calls, you can check Standard or 3.1 kHz Audio or both.
If you check both, any device connected to the Phone/Fax interface will
react (ring) on incoming calls.

If you select e.g. Standard, the Phone/Fax interface will only react on
calls made to the Standard phone number.

* For Outgoing calls, you can select either Standard or 3.1 kHz Audio.
The selected type will be used by default, if possible, for any outgoing
call. Note, however, that fax machines and modems must use 3.1 kHz
Audio.

m You can override the default setting for outgoing calls by dialing
1* (force the call to Standard) or 2* (force the call to 3.1 kHz
Audio) before the number. For further information, see
Overriding the default outgoing call type on page 40.
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3. Click Apply.
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Configuring the ISDN interface

m For information on how to set up call services (supplementary
services), see Setting up call services on page 97. These settings
apply to both the Phone/Fax interface, the ISDN interface and the

LAN w. PoE interface.

To configure the ISDN interface, do as follows:

1. Select SETTINGS > ISDN.
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2. Set the call type(s) for incoming calls.
You can select Standard, 3.1 kHz Audio, UDI and/or RDI. Note that for
TracPhone FB250 you can only select Standard or 3.1 kHz Audio.

m Connected devices will only receive incoming calls with the call

types that are selected here.
For example, if only Standard is selected, and a G4 fax call

(using call type UDI) arrives, a fax connected to the ISDN port
will not receive the incoming call.
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3. Set the MSN numbers that are to be assigned to each call type.

Note that this setting only applies to the call type selected above the MSN
number, and only if the connected device supports the call type used.

m If you set an MSN number to anything other than <None>,
connected devices must be programmed with these MSN
numbers.

You have the following options with the MSN numbers:

* <None>. No MSN numbers are used. An incoming callis accepted in all
devices connected to this port.

o 1%, 2% 3* or 4*: If, for example, you select 1* at Standard call type, an
incoming Standard call is accepted by all devices that are programmed
with the number 1* and connected to the ISDN interface.

e 0401, 0402: These are local numbers for separate devices connected to
the ISDN interface.
Anincoming call is accepted by devices that are programmed with the
selected number and connected to the ISDN interface.

You can combine the MSN settings.

Example: You have two devices connected to the ISDN interface. One is
programmed with the numbers 1* and 0401, the other is
programmed with 1* and 0402.

In the web interface, you select the MSN number 1* under
Standard.

If an incoming Standard call arrives, both devices will accept
the call.

If you make a local call to one of the local numbers 0401 or
0402, only the called device will accept the call.
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4. Set the call type for outgoing calls.

* If you select Automatic, the call type will be determined by the calling
device.

* Ifyou select Standard, all outgoing calls, except UDI/RDI, will use the
call type Standard. If you make a 3.1 kHz Audio call it will be converted
to a Standard call.

Outgoing UDI or RDI sessions will be not be influenced by this setting.
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If you select 3.1 kHz Audio, all outgoing calls, except UDI/RDI, will use
the call type 3.1 kHz Audio. If you make a Standard call it will be
converted to a 3.1 kHz Audio call. Outgoing UDI or RDI sessions will be
not be influenced by this setting.

m You can override the call type setting for outgoing calls by
dialing one of the following prefixes before the number:

e 1* (force the call to Standard)
e 2* (force the call to 3.1 kHz Audio)

Refer to Overriding the default outgoing call type on page 40.
5. Click Apply.
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Setting the common interface settings

The common APN

The common APN setting is defined here and can be selected for each network
user group. If you are using the same APN for many network user groups, it is
easier to define it once, and then simply select it for the relevant user groups.
Also, if you change the common APN at a later stage, it is automatically
updated for all network user groups where the Common setting is selected.

To set up the common interface settings

Do as follows:

1. Select SETTINGS > Common.
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2. Select the APN. You have the following options:

* SIM default. The APN is taken from the SIM card. This is the
recommended option, unless you have special requirements.

* Network assigned. The APN is assigned from the network.

* User defined. Type in the APN. APNs are provided from the Airtime
Provider.

3. At Buffering on Streaming profiles, select Enabled or Disabled.

» Ifyou select Enabled, your Streaming connection will be buffered. This
means that the transmission is slightly delayed in order to ensure a
precise and continuous data stream.

* Ifyou select Disabled, your Streaming connection will not be buffered.
This means the data is delivered immediately, but may vary slightly in
transmission speed.

4. Click Apply.

How to use the common APN

When you configure the APN for your individual network user group, select
Common to use the setting from this page.

Where Common is selected in the individual groups, the setting will
automatically be updated when the Common APN is changed.
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Setting up call services

Overview

m The terminal must be registered on the BGAN network before you
can set up the call services in the web interface.

In the web interface you can set up the following supplementary services:
+ Callforwarding

* Call barring

* Call waiting

* Line identification

* Closed user group

Note that, depending on the network, some of these call service settings may
prevent others from being activated.

The settings apply for all connected devices using a circuit-switched service.
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Call forwarding

L

phone number. Do as follows:

Line identification Farward if na reply

Closed user group DATA/ISDN

1P handsets Forward all calls

Discrete 1/0
4 Formard when busy

Upload
Forward if not reachable
satellite selection

Forward if no reply

ADMINISTRATION
HELPDESK Apply | _cSaneel
SITE MAP

fram being activated

4l
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DASHEOARD Read current settings Ok
PHONE BOOK
e STANDARD YOICE
CALLS Formard all calls ™ Enabled
SETTINGS Forward when busy ¥ Enabled
LN Forward if not reachable ¥ Enabled
Phone/Fax
Forward if na reply ¥ Enabled
1SDN
3.1 KHZ AUDID
Common
Farward all calls ™ Enabled
all forward
Farward when busy [ Enabled
call barring
Call waiting Forward if not reachable [ Enabled

™ Enabled

™ Enabled
™ Enabled
™ Enabled

™ Enabled

You can set up the terminal to automatically forward incoming calls to another

Select SETTINGS > Common > Call forward from the left navigation pane.

on4s39s58800
on4s39s58800
jo04539558800 when unanswered in [20 Sec x

when unanswered in [20 Sec x

when unanswered in |20 Sec ¥

Please note that some active call farward, call barring or call waiting settings
may prevent other call forward, call barring or call waiting settings

]

[ [ [ 4 meemer

N

2. For each call type, select Enabled next to the situation(s) in which you

want to forward incoming calls.

3. Next to the enabled items, type in the phone number you want to forward

the call to.

4. Ifyou have selected Forward if no reply, select from the drop-down list the

period of time the system should wait before forwarding the call.

5. Click Apply.
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Call barring

Do as follows to bar incoming and/or outgoing calls to and from the terminal:

1. Select SETTINGS > Common > Call barring from the left navigation pane.

™ Bar all outgoing calls
Discrete [/0 e
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2. Click OK next to Read current settings, to make sure the page is updated.
3. For each call type, select which calls should be barred.

4. Inthe Barring PIN field, type in a PIN for your call barring setup.

m This is not the SIM PIN entered at startup, but a network PIN
which is supplied together with your SIM PIN.

5. Click Apply.
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Call waiting

You can set up whether or not you want to receive notification of waiting calls
while you are making a call or transmitting data.

Do as follows:

1. Select SETTINGS > Common > Call waiting from the left navigation pane.
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2. Click OK next to Read current settings to make sure the page is updated.

3. For each call type, select Call waiting enabled if you want to get
notification of waiting calls while you are making a call or transmitting
data.

4. Click Apply.
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Line identification

You can set up the terminal to show your number when you are making a call
or transmitting data.

Do as follows:

1. Select SETTINGS > Common > Line identification from the left navigation

pane.
-
Thrane & Thrane
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2. Select Show my number and click Apply.
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Closed user group

Your subscription may include one or more closed user groups. A closed user
group is a group of users permitted to make calls to each other but not to
users outside the group.

To define the settings for these user groups, do as follows:

1. Select SETTINGS > Common > Closed user group from the left navigation

pane.
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2. Typein your user group number(s) under Group no.

3. Select which group(s) should be active.

If you select Subscribed, the group(s) included in your subscription will be
active.

102 Setting up the interfaces



Chapter 4: Using the web interface

4. To allow outgoing access for the activated user group(s), select Outgoing
Access under SETTINGS FOR ACTIVE CLOSED USER GROUP. Note that if you
selected Subscribed above, this setting will not be used.

5. Select Preferential if you want the activated user group to be selected
when a member of a user group does not specify the group number during
call set up. Note that if you selected Subscribed above, this setting will not
be used.

6. Click Apply.
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Managing IP handsets

Overview

The terminal has & LAN (PoE) connectors for connection of IP handsets or
other IP equipment. You may connect your IP handsets directly to the LAN
interfaces or use a PoE switch to connect more handsets. The TracPhone
terminal supports connection of up to 16 handsets.

Each handset must have a local number in the range 0501 to 0516 as well as a
unique password.
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Connecting a new IP handset

m The first handset that is connected to the LAN interface on the
terminal is automatically registered in the terminal and assigned the
local number 0501 and password 0501.

To connect a new IP handset, do as follows:

1. Connect the IP handset to one of the LAN ports of the terminal.
2. Inthe web interface, select SETTINGS > IP handset.

SIGNAL: uuuuuuu
Entry Number Handset password Actions Configure handset
DASHBOARD
1 0501 0501 Edit/Delete Configure )
PHONE BOOK )]
2 0502 Hew Not active S
MESSAGES “—
3 0503 Hew Not active P
caLLS [
4 0504 Hew Not active E
SETTINGS . 0505 u I o—
e ot active
LAN ==
3 0508 Bew Not active (<%}
(iomeFers 7 0507 New Not active =
()
1SDN (] 0508 Mew Not active =
=1
Commaon 9 0509 Hew Not active o
1P handsets 10 0510 New Not active £
w
Call settings 11 0511 Hew Not active )
Discrete /0 12 0512 Hew Not active
Upload 13 0513 Hew Not active
y 5 14 0514 Hew Not active
Satellite selection
15 0515 Hew Not active
ADMINISTRATION
16 0516 Hew Not active
HELPDESK
SITE MAP

3. Next to the local number you wish to use, click New.

4. Enter the password you want for your IP handset.
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5. IntheIP handset, use the display menu system to enter the local number
and the password you just entered in the web interface. Do as follows:

* Enter the menu system and select SIP to get the list of profiles.
» Select the BGAN profile and select Options.
* Select Edit/View and change the user name and password. Note that

the user name is also the local number for the handset.

When the terminal and the handset have recognized each other, a Configure
link appears next to the handset in the IP handsets page of the web interface.
This link provides direct access to the built-in web interface of the IP handset.
For further information, refer to the user manual for the IP handset.
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Setting up the IP handsets

Do as follows:

1. Select SETTINGS > IP handset.

Thrane & Thrane
SIGNAL: nnooooo
Entry Number Handset password Actions Configure handset
DASHBOARD
1 0501 0501 Edit/Delete Configure
PHONE BOOK
H 0502 Hew Not active
MESSAGES
3 0503 Hew Hot active
CALLS
4 0504 Hew Hot active
SETTINGS
5 0505 Hew Not active
LAN 6 0506 Hew Not active
Hieme/iFes 7 0507 Hew Not active
I5E6 8 0508 Hew ot active
Common 9 0509 Hew Not active @
IP handsets 10 0510 Hew Not active %
Call settings 11 0511 Hew Not active =
[
Discrete 170 12 0512 Hew Not active =
— 13 0513 Hew Not active
14 0514 H Mot act
satellite selection e ot sctve <
15 0515 ew Not active =
ADMINISTRATION @
16 0516 ow Mot active =
HELPDESK =
SITE MAP (=2}
c
wv)
o

2. Select Edit next to a handset to change the password of the handset.

Remember that you must enter the same password and local number (user
name) in the IP handset.

3. Select Delete next to a handset to delete it from the list.

When a handset is deleted from the list, you can no longer access the
terminal with this handset.

4. Select Configure next to a handset to enter the built-in web interface of the
IP handset.

With the web interface of the IP handset you can access the internal
settings of the IP handset. For further information, refer to the user
manual for the IP handset.
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Setting the call types for IP handsets

Do as follows:

1. Select SETTINGS > IP handsets > Call settings.

DASHBOARD
Number Incoming calls Outgoing calls
PHONE BOOK
0501 ¥ standard W 3.1 kHz Audio Standard © 3.1 kHz Audio
MESSAGES
0502 ¥ standard ¥ 3.1 kHz audic @ Standard € 3.1 kHz Audio
CALLS
SETTINGS 0503 ¥ Standard W 3.1 kHz Audic  © Standard © 3.1 kHz Audio
LAN 0504 ¥ Standard ¥ 3.1 kHz Audio @ Standard © 3.1 kHz Audio
Phone/Fax 0505 ¥ Standard ¥ 3.1 kHz Audia @ Standard € 3.1 kHz Audia
1SDN
0506 ¥ standard W 3.1 kHz Audio Standard © 3.1 kHz Audio
Common
0507 ¥ standard ¥ 3.1 kHz audic Standard € 3.1 kHz Audio
1P handsets
. 0508 ¥ Standard W 3.1 kHz Audie @ Standard © 3.1 kHz Audio
Call settings
Discrete 1/0 0509 ¥ standard ¥ 3.1 kHz Audie @ Standard © 3.1 kHz Audio
Upload 0510 ¥ Standard ¥ 3.1 kHz audio  Standard © 3.1 kHz Audio
Gaalliiebelection 0511 ¥ standard ¥ 3.1 kHz audic @ Standard € 3.1 kHz Audio
ADMINISTRATION
0512 W standard M 3.1 kHz Audio @ Standard © 3.1 kHz Audio
HELPDESK
0513 ¥ Standard W 3.1 kHz Audic @ Standard © 3.1 kHz Audio
SITE MAP
0514 ¥ Standard W 3.1 kHz Audio @ Standard © 3.1 kHz Audio
0515 ¥ standard W 3.1 kHz Audio Standard © 3.1 kHz Audio
0516 ¥ standard ¥ 3.1 kHz audic Standard € 3.1 kHz Audio
Apply| _cancel

2. For each handset, select the call types you want to enable for incoming
and outgoing calls.

The call types are described in more detail in Selecting the call type on
page 39.

* For Incoming calls, you can check Standard or 3.1 kHz Audio or both.
If you check both, the handset will react (ring) on any incoming call.
If, for example, you select Standard, the handset will only react on
calls made to the Standard phone number.

* For Outgoing calls, you can select either Standard or 3.1 kHz Audio.
The selected type will be used by default, if possible, for any outgoing
call.

3. Click Apply.
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Configuring the discrete I/0 interface

Overview

The I/0 interface on the terminal has 5 configurable I/0 pins. You can set up
the function of each pin in the web interface. The default functions of the I/0
pins are as follows:

Pin 1: Ringer output.

This pin changes state from low to high when the terminal is notified of an
incoming call from the satellite interface. When the call is answered, or
the caller gives up and releases the call, the pin changes back to low.

Pin 2: Warning/Error output.
This pin provides an external signal that indicates active warning/error
condition(s). The signal stays active until all warnings/errors are cleared.

Pin 3: Mute output.

The mute output pin provides an external signal that is active during a
phone call. The signal can be used to mute external equipment, such as a
car-radio.

Pin 4: Radio silence input.

When active the terminal observes Radio Silence. The terminal gracefully
closes all open connections, and deregisters from the BGAN network. No
transmission is allowed until the pin is deactivated.

Pin 5/8: Ignition input.

The ignition function uses pin 5 together with pin 8 (DCin). Connect the
appropriate pin to the ignition key switch as follows:

If the input should be active high, connect pin 5 to Ground, and use pin 8
to switch on the terminal by pulling it high (10-32 V DC).

If the input should be active low, connect pin 8 to positive DC voltage, and
use pin 5 to switch on the terminal by pulling it low (< 1.2 V DC).

m The Ignition function is normally not used in maritime
installations. You may use the Remote on/off function in the
power connector instead.
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Configuring the I/0 interface

To configure the I/0 pins, do as follows:

Select SETTINGS > Discrete 1/0.

SIGNAL: nnnooon
DASHEOARD DISCRETE 1/0
PHONE BOOK Pin /0 Function  Enabled Polarity
MESSAGES 1 Output Ringer T active high  Active low
CALLS
z Output Warning T @ active high ¢ active low
SETTINGS
3 Output Mute T @ active high © Active low
LAN
4 Input Radio silence (el @«
—— i r Active high @ Active low
ISDN 3 Input Ignition € active high @ Active low
Common
DELAYED SHUTDOWN
1P handsets
Dela o -] (Minutes
Discrete 1/0 4 g B
upload
RINGER OUTPUT
Satellite selection
Incaming ealls [~ standard ™ 3.4 kHz Audio T uDT [T ROI
ADMINISTRATION
HELPDESK MUTE DUTPUT
SITE MAP
Incoming ealls ™ standard [ 3.1 kHz Audie T uDI T~ RDI
Apply| _cancel

For each pin you want to use, select Enabled.
For each pin, select if the pin should be Active high or Active low.

If you are using the Ignition function and you want the terminal to stay on
for a few minutes after the Ignition is switched off, enter the number of
minutes under DELAYED SHUTDOWN.

For further information on the Ignition function, see Using the ignition
system on page 22.

If you are using a ringer output, select the incoming call types that should
activate the ringer under RINGER OUTPUT.

If you are using a Mute output, select the incoming call types that should
activate the Mute function under MUTE OUTPUT.

Click Apply.
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Managing LAN network users

Introduction

The network management system

The network management system divides the users of the TracPhone terminal
into network user groups. Each network user group has a profile which
determines how the users connect to the Inmarsat BGAN network. The
network user groups can allow or restrict certain services for different users.

For example, you may want to define:

* one network user group for Bridge communication, allowing both
Standard and Streaming connections,

* one network user group for Crew welfare, allowing Standard connections,
* one network user group for IP handsets, allowing no Internet access.

* one network user group for Remote management of systems at the bridge
or in the engine room. This would be a direct Standard connection (Bridge
mode).
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The TracPhone terminal supports up to 11 different network user groups and
global IP addresses.
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Necessary steps when managing network users

The steps necessary for managing network users include:

L

Defining a network user group. See Setting up the network user groups on
page 113.

The network user groups determine settings such as:
* QoS (Standard/Streaming),
» IP addressing (Static/Dynamic)

* Internet access mode (Router Mode/Bridge Mode/No Internet Access)

Identifying a network device. See Managing network devices on page 119.

The network devices are identified by their IP address, MAC address and
(optionally) device name.

Associating the network user group and the network device. See Using the
network classification table on page 121.

The network classification table determines which devices should belong
to which network user group. When a network device is connected, the
terminal runs through the network classification table to check if the new
connection matches any of the entries in the table. When a match is found,
the terminal establishes a PDP context and the device is ready for use with
the terminal.

Access to the network management settings

Access to the network management settings requires an Administrator
password.

The Administrator can create and manage network user groups and set up a
network classification table defining priorities for devices, network groups and
LAN ports.

ACauﬁon! All user connections to the LAN interface may be affected
when you change the settings below, including your own
current connection.
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Setting up the network user groups

Overview

A network user group, in this context, is a group of network users sharing the
same Quality of Service profile and network parameters.

There are 11 configurable network user groups. For the Default user group,
certain settings are locked, to make sure there is always one functional user
group available. For example, the Default user group does not allow you to
select a Bridge mode connection.

m The network user groups cannot be deleted. If you do not want to
use them, click Edit and select Disabled at Status in the NETWORK
USER GROUP field.
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Editing a network user group

m For further explanation of the terms used below, see Definitions for

network terms on page 124.

Do as follows:

L

Select SETTINGS > Network user groups.

When you are prompted, enter the Administrator user name and
password. The default user name is admin and the default password is
1234.

4

Thrane & Thrane

SIGNAL:

DASHBOARD

PHONE BOOK

MESSAGES

CALLS

SETTINGS

LAN
Port forwarding
Network devices
Network classification
Network user groups

PhonefFax

1SDN

Common

IP handsets

00ooooo

NETWORK USER GROUPS

Name

Group 0
Group 1
Group 2
Group 3
Group 4
Group §
Group 6
Group 7
Group 8
Group 9

Default group

Status

Enabled

Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled
Disabled

Enabled

Internet
connection

Router mode
Router mode
Bridge mode
Router mode
Router mode
Router mode
Router mode
Router mode
Mo internet access
Router mode

Router mode

Automatic

activation

Enabled Edit
Enabled Edit
Enabled Edit
Enabled Edit
Enabled Edit
Enabled Edit
Enabled Edit
Enabled Edit
Enabled Edit
Enabled Edit
Enabled Edit

]

| [$dLocalintranet
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2. Click Edit next to the user group you want to set up.

SIGNAL: aoooooo
NETYORK USER GROUP
DASHBOARD
Mame Group O
PHONE BOOK
Status @ Enabled  Disabled
MESSAGES
Internet connection Router mode vI
CALLS
Changes to Status and Internet connection only take effect after reboot
SETTINGS
TCP/IP
LAN

Port forwarding
Metwork devices
Metwork classification
Metwork user groups
PhonefFax
I1SDN
Common
IP handsets
Discrete I/0
Upload
Satellite selection
ADMINISTRATION
HELPDESK

SITE MAP

Lo Dynamic IF address
 Static IP address
IP Header comnpression
APN

 Common

& SIM default

" Network assigned
© User defined

User name

Password

PROFILES

Autornatic activation

Frimary

Secondary

PROFILE CIDS
Profile

Streaming 128

apply | _cancel |

# Enabled " Disabled

[Fo=r.inmarsat.com

—
—

@ Enabled (" Disabled

Standard
Streaming 32
Straamning 64

Streaming 236
User defined 1
User defined 2

Standard
Streamning 32

Streaming 64

Streaming 126
Streaming 256
User defined 1
User defined 2

cid
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3. Typein a name for the group.

4. Select Enabled or Disabled.
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5. Select the type of Internet connection.

* Router mode means the connection will be shared with other users,
and the NAT module of the terminal will make the necessary address
translations. Use this mode if one or more computers are connected
using the LAN interface, and the terminal should act as a router.

* Bridge mode is an exclusive connection, with NAT disabled. Use this
mode together with a network classification entry that selects a single
computer (see Using the network classification table on page 121). This
mode is not available in the Default user group.

* Nointernet access means no connection to the Internet is allowed. Use
this setting e.g. for IP handsets, where an Internet connection is not
required. The external voice connection is still available; this setting
only affects communication over the Internet.

6. Select Dynamic IP address.
This is the IP address used externally on the satellite network.

If you want to use a static IP address, and your subscription allows it, you
must still leave this setting at Dynamic. Then select SIM default in step 8
and type in the APN user name and password from your provider in step 9.

Your terminal will then use the static IP address set up for your SIM card.

m Typing in a static IP address is currently not supported by the
BGAN network.

7. Set IP Header compression to Enabled or Disabled.

For information on IP Header compression, see Header compression on
page 124.

8. Select the source of the APN (Access Point Name).

There are four options for setting the APN. Unless you have special
requirements, it is recommended to use the SIM default, or to set the
common APN to SIM default, and then select Common here. You have the
following options:

* Common. The APN is taken from the Common APN defined under
SETTINGS > Common. Refer to Setting the common interface settings
on page 95.
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9.

10.

11

*  SIM default. The APN is taken from the SIM card. If you want to use a
static IP address on the external network, select this option either here
orin the Common setting.

* Network assigned. The APN is assigned from the network.

» User defined. Type in the APN. APNs are provided from the Airtime
Provider.

If your APN uses a password, type in the user name and password
provided from the Airtime Provider.

m If you are going to use the static IP address from your SIM card,
the user name and password are mandatory! See step 6 above.

At Automatic activation select whether the profile selected in the next step
should be activated automatically or manually.

m If the selected primary profile is a Streaming profile, this setting
has no effect. Streaming profiles must always be activated
manually from the Dashboard.

» Disabled means you can activate/deactivate the profile from the
Dashboard.

* Enabled means the profile is activated automatically.

Select the Primary profile.

Select a profile from the Primary scroll list. This profile is used by this
network user group as a first choice, when possible.

There are 5 predefined profiles (4 in the TracPhone FB250): Standard,
Streaming 32 kbps, Streaming 64 kbps, Streaming 128 kbps and Streaming
256 kbps (only TracPhone FB500). Additionally, you can define your own
custom profiles.

m If you have selected a Streaming connection as your
primary profile, the LAN interface will be running a

Streaming connection until you stop it or disconnect the
interface. However, if you select one or more secondary
profiles, you can set up your traffic flow filter so that it will
only use the Streaming profile for certain types of traffic.

Managing LAN network users 17
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For further information on profiles and traffic flow filters, see Using
profiles on page 139 and Using traffic flow filters on page 143.

12. Select the Secondary profile.
To select more than one secondary profile, press and hold Ctrl or Shift
while selecting.

m If you have selected both a primary and one or more secondary
profiles you must define a traffic flow filter before you can
establish a valid connection.

The Context Identifiers (CIDs) for the selected primary and secondary
profiles are listed under Profile CIDs.

13. Click Apply.
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Managing network devices

Overview

A network device, in this context, is an Ethernet hardware device, identified by
a unique MAC address.

When a network device with dynamic IP address is connected to the terminal,
itis automatically listed in the Network devices list.

Viewing the list of network devices

To view the list of network devices, select SETTINGS > Network devices.

All network devices that have been connected to the terminal are listed here.

(]
R R R R R o
i i
=
| Thrane & Thrane o
=
o)
noononn g
(]
=
LOCKED IP ADDRESSES =
DASHBOARD o
IP address MAC address c
PHONE BOOK ‘a
192168114 00:18:F6:09:09:09 Delete D
MESSAGES
192.168.11.11 00:16:FE:09:BF:04 Delete
CALLS
192.165.11.12 00:18:F5:09:09:0C Delete
SETTINGS
LAN NETWORK DEYICES
part farwarding IP address MAC address Device Name
192.168.0.2 00:18:F5:09BD:D4 device-n0 Lock ip to mac address
Network devices
o 192168111 00:16:F5:09:09:06 device-1 Lock ip to mac address
Metwork classification
192.168.11.2 00:18:F8:09:09:07 device-2 Lock ip to mac address
Network user groups
192.16811.3 00:18:F6:09:09:08 device-3 Lock ip to mac address
PhonefFax
192168114 00:18:F5:09:09:09 device-4
ISDN
192.168,11.5 00:18:F8:09:09:04 device-5 Lock ip to mac address
Commen 192.18811.6 0D0:16:FE:09BF:07  device-6 Lack ip to mac address
P (ol 192468117 O00:18:F8:09iBFi05  device-7 Lock ip to mac sddress
Discrete 170 192.168.11.8 00:18:F8:09:B8:07  device-8 Lock ip to mac address
Upload 192.168.11.9 00:18:FG8:090:BF:03 device-9 Lock ip to mac address
Satellite selection 192.163.11,10 00:18:F8:09:0A:07 device-10 Lock ip to mac address
ADMINISTRATION 192.168.11.11 00:18:F6:09:BF:04 device-11
HELPDESK 192.168.11.12 00:18:F§:09:09:0C device-12

Managing LAN network users 119



Chapter 4: Using the web interface

Locking an IP address to a MAC address

When the device is locked to an IP address, the terminal will always assign
this IP address to the MAC address of this device (if DHCP is enabled and the
Internet connection is not a Bridge mode connection).

To lock a device to its current IP address, click the link next to the device.
The device is then locked to the current IP address and added to the list of
locked IP addresses at the top of the page.

To unlock a device from the IP address, click Delete next to the device in the
LOCKED IP ADDRESSES list.
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Using the network classification table

Overview

The network classification table is used for making an association between
network devices and network user groups.

Each entry in the table shows MAC address, IP address, LAN port and network
user group.

When a network device is connected, the terminal runs through the network
classification table to check if the new connection matches any of the entries
in the table. When a match is found, the terminal establishes a PDP context
and the device is ready for use with the terminal.

Adding or editing an entry in the network classification table

To add a new entry to the table or to edit an existing entry, do as follows:

1. Select SETTINGS > Network classification table.

Thrane & Thrane

SIGNAL: uuuuuuu

NETWORK CLASSIFICATION TABLE
DASHBOARD

MAC address 1P address LAN port  Network user group
PHONE BOOK
3 Graup 0 ¥  Edit/Delete
MESSAGES
2 Group 0 a  Edit/Delete

CALLS
Default group
SETTINGS
add
LAN
Changes to this page only take effect after reboot
Port forwarding

Network devices
Metwork classification
Metwork user groups

PhonefFax

1SDN

Common

1P handsets

J | o

L] [0 [ [ [S3iocalintranet A
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The network classification table shows which devices are associated with
which LAN ports and network user groups. An Asterisk (*) is a “wild card”,
meaning that any value is accepted.

2. Click Edit next to the entry you want to edit, or click Add at the bottom of
the list.

SIGNAL: uuuuuuu

EDIT ENTRY
DASHBOARD
Enter values below or select a device from the list of known netwerk
PHONE BOOK devices to Use that as a template. If a field is Isft empty it will be
considered a wild card

MESSAGES
MAC address *
CALLS
CETTINGS 1P address o
LAN LAN port 7 s
G o -
Port forwarding Metwork user group [Graom
e — pply| Cancal|
Metwork classification NETWORK DEYICES
AT S —— IP address MAC address Device Name
Phone/Fax 192.168.0.2 00:16:F8:09:BD:D4 device-0 add
118:F8:09:09; device-1
ISDN 192.168.11.1 00:18:F8:09:05:06 Add
192 188.11.2 00:18:F8:09:09:07 device-2 add
Common
192.1858.11.3 00:18:F8:09:09:08 device-3 add
IP handsets
192,185,114 00:18:F8:09:09:09 device -4 add
Discrete [0
192.1858.11.5 00:18:F8:09:09:04 device -5 add
upload
192.188.11.6 00:18:F8:09:BF:07 device -6 add
Satellite selection 192.1858.11.7 00:18:F8:09:BF:05 device-7 add
ADMINISTRATION 192.185.11.8 00:18:F8:09:B&:07 device -8 add
GLLELAEEEE 192.185.11.9 00:18:F8:09:BF:03 device -9 add

3. Click Add next to a network device you want to use, or type in the MAC
address manually at the top of the page.

m If you leave a field empty, it is the same as a “wild card” and it
will be shown as an Asterisk in the Network classification table.

Unless you are using a Static IP address, the IP address field
should always be left empty.

4. Select the LAN port and Network user group you want to associate with
the device.

Network user groups are created and defined in the Network user group
page. See Setting up the network user groups on page 113.

5. Click Apply.

122 Managing LAN network users



Chapter 4: Using the web interface

Removing an entry in the network classification table
In the network classification table, click Delete next to the entry you want to
delete.

Changing the priority in the network classification table

To change the priority of an entry, click the up or down arrow next to the entry.

Thrane & Thrane
SIGNAL: uuuuuuu
NETWORK CLASSIFICATION TABLE
DASHBOARD
MAC address IP address LAN port Network user group
PHONE BOOK
3 Group 0 ¥  Edit/Delete
MESSAGES
2 Group 0 A Edit/Delste
()
CALLS 9
Default group o
SETTINGS " “—
1
[
LAN -
Changes to this page only take effect after reboot c
Port forwarding o=
o)
Netwark devices clg)
Netwark classification
()
Network user groups =
Phane/Fax =3
4 =
1SDN &
]
Common
IP handsets
4 |
& [T T [ [N3tecalintranet

Connections are evaluated in the order they are listed. The first entry (and only
the first entry) that matches the properties of the connected device is applied,
meaning that the connection will be using the settings of the user group
assigned to that entry.

The Default user group is always last, so it is only used if none of the other
entries match the properties of the connected device.
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Definitions for network terms

APN (Access Point Name)

The APN is used by the network user to establish the connection to the
required destination network. This means that the terminal must know the
APN in order to be able to connect to the destination network.

APNs are provided from the Airtime Provider. They may also be defined on the
SIM card.

Header compression

The Header of a data packet contains control information belonging to that
packet. The information in the Header can take up a considerable amount of
bandwidth. In order to save bandwidth, you can use Header Compression,
meaning you compress the header information, leaving some of the
information out.

You can select whether or not to use Header Compression for your data
transmission.

* Header Compression enabled: Recommended for low-noise applications.
If you select Header Compression enabled, you will be using less
bandwidth on header information, leaving more bandwidth for the actual
payload.

However, if the environment is noisy, the system will have to retransmit
information, and you may end up using more bandwidth than without
Header Compression.

* Header Compression disabled: Recommended in noisy environments.
If Header Compression is disabled, the system will be less sensitive to
noise.
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Profiles

A profile is a collection of Quality of Service (QoS) settings and other settings
defining the mode in which data is transmitted on an interface. For example, a
profile is used to define whether a connection should be a Standard or
Streaming connection.

You can select between a number of predefined profiles or define your own
profiles for your data transmission.

m If you have selected more than one profile (one primary and one or
more secondary profiles) for an interface, you must define a traffic
flow filter before you can establish a valid connection.

You need an Administrator password to define profiles and traffic flow filters.

NAT (Network Address Translation)

NAT enables a local-area network to use one set of private IP addresses for
internal traffic and an assigned or static IP address for external traffic. The
built-in NAT module in the terminal makes all necessary address translations
between the local-area traffic and the external traffic.

If more than one user is connected, you must select a network user group with
Router mode to use the NAT of the terminal.
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Uploading software

Introduction

You can upload software from your computer to the terminal without entering
the PIN. However, if your SIM card requires a PIN and the PIN is not entered,
you must enter the Administration user name and password.

The web interface also offers the possibility of downloading the latest software
version from the Internet to your computer.

The next pages describe how to upload software from your computer to the
terminal and how to download software from the Internet to your computer.
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Uploading software from your computer
To upload software from your computer to the terminal, do as follows:

1. Download the new software as described in the next section, or acquire
the software from KVH Industries and save it on your computer.

2. Open the web interface and do one of the following:

+ Ifthe PIN has been accepted (or a PIN is not required), select
SETTINGS > Upload from the left navigation pane.

» IfaPINis required and the PIN has not been entered, select
ADMINISTRATION, enter the Administration PIN and password and
click Logon.

The default user name is admin and the default password is 1234.
Then select Upload from the left navigation pane.

The SOFTWARE UPLOAD page opens.

(¥}
o
(]
<0
o
[}
=
=
Thrane & Thrane o
o0
=
SIGNAL: noooooo (<]

=
=
(=]

DASHBOARD CHECK FOR SOFTWARE UPDATES 1=

PHONE BODK Current seftware version 01,01 5

MESSAGES Check for updates

ELALLS Latest available Mot checked...

SETTINGS File size

LAN

Phone/Fax

ISDN

UPLDAD SOFTWARE TO TERMINAL
Common
1P handsets Bowe. | _Upload | |

Discrete 1/0

upload Disclaimer for Downloading and Uploading softeares:
Please be informed that dewnloading and installing software from the Thrane &
Satellite selection Thrane web portal is at your own risk, Thrane & Thrane is not to be held
liable for any possible darnmage with respect to downloading and installing
ADMINISTRATION software to your SAILOR 500 FleetBroadband.
HELPDESK If you have problems or questions with respect to downleading software or

uploading your terminal please be informed that you will have to contact the
Thrane & Thrane distributor fram where the terminal was purchased or contact
SITE MAP your local Thrane & Thrane distributar.
Please be advised that you will nat be able ta contact Thrane & Thrane for end
user support and that we always recammend that software upgrades are being
carried out by official Thrane & Thrane distribution partners

4 | 3

[0 [ [T 4 meernet

RN
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In the field UPLOAD SOFTWARE TO TERMINAL, click Browse...
Browse to the new software version and accept it.

Click the Upload button.

o woF W

Note that the upload procedure takes a couple of minutes.

m When upload is done, your terminal automatically restarts with
the new software.
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Downloading software from the Internet

LIl ell® | The terminal uses your BGAN airtime subscription to download
the new software from the Internet. Note that it can take
several minutes to download the software.

To download the latest software from the Internet to the terminal, do as
follows:

1. Make sure you have a connection to the Internet from your terminal.

2. Open the web interface and select SETTINGS > Upload from the left
navigation pane.

Thrane & Thrane
SIGNAL: Ooooooo
DASHBOARD CHECK FOR SOFTWARE UPDATES
PHONE BOOK Current software wersion 01.01
MESSAGES Check for updates
CALLS Latest available Hot checked ..
SETTINGS Fils size
LAN
Phone/Fax
ISDN
UPLOAD SOFTWARE TO TERMINAL
Common
IP handsets _Bromss. | _uplosd | -

Discrete 1/0

Upload Disclaimer for Dawnloading and Uploading software:
Please be informed that dawnloading and installing software from the Thrane &
satellite selection Thrane web partal i at your own risk. Thrane & Thrane is not ta be held
liable for any possible damage with respect to downloading and installing
ADMINISTRATION software to your SAILOR 500 FleetBroadband.

If you have problems or qusstions with respect to downloading softwars or

LEERDESE uploading yaur terminal please be informed that you will have to contact the
Thrane & Thrans distributor from whers the terminal was purchasad or sontact
SITE MAP your local Thrane & Thrane distributor,

Please be advised that you will not be able to contact Thrane & Thrans for end
user support and that we always recommend that software upgrades are being
carried out by official Thrane & Thrane distribution partners.

J | o

[Ei] N 4

3. Click Check for updates.
The terminal will now connect to the Internet through the BGAN network,
using your airtime subscription. It may take a minute or two to obtain the
new software version.

Uploading software 129

)
o
©

i
=
]

2
=

=y
)
=
)

<

=
=)
=
&

)




Chapter 4: Using the web interface

When the new software version is found, the web interface shows the new
software version and a link for downloading the software.

Click the link to download the new software to your computer.

After saving the software, follow the procedure in the previous section
(Uploading software from your computer) to upload the software from the
computer to your terminal.
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Selecting the preferred BGAN satellite

Overview

By default the terminal is set up to automatically find the most appropriate
satellite to connect to (“Auto” mode). However, if you are located in an area
with more than one BGAN satellite available, you can select the satellite you
prefer to use when registering on the BGAN network.

To select the preferred BGAN satellite

Do as follows:

1. Select SETTINGS > Satellite selection from the left navigation pane.

Thrane & Thrane

SIGMAL: uuuuuuu

DASHEOARD Satellite selection: [1oR

AOR
PHONE BOOK POR
MESSAGES

CALLS Apply I Cancel I

SETTINGS

)
o
©

i
=
]

g
=

=y
)
=
)

<
=
=)
c
&

)

LAN

PhonefFax

ISDN

Common

IP handsets
Discrete [0
Upload

Satellite selection

ADMINISTRATION

=
« | »

] pone [T T enene

Selecting the preferred BGAN satellite 131



Chapter 4: Using the web interface

2. Select the satellite you prefer to use.

If you select Auto (the default setting) the TracPhone system
automatically uses the most appropriate satellite.

Note that at this writing the POR satellite is not yet available.

LS ER® | If you have any ongoing calls or data sessions, they will be
terminated when you click Apply!

3. Click Apply.

The TracPhone terminates all ongoing connections and deregisters from
the current satellite before registering on the new satellite.

m If you have selected a satellite, your TracPhone system will only try to
establish a connection to the selected satellite. This means that if the
antenna is outside the coverage area for that satellite, the TracPhone
system will not be able to register with the BGAN network.
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Administration

Accessing the administration settings

Logging on

The Administration settings require an Administration user name and
password.

1. Select ADMINISTRATION from the left navigation pane.

2. Enter the Administration user name and password.
The default user name is admin and the default password is 1234.

SIGNAL: aooooon
Please enter administrator usernarme and passward
DASHESAED ADMINISTRATOR LOGON
PHONE BOOK B DEGE fedrein L
MESSAGES Password: Inoo
SETTINGS
ADMINISTRATION
HELPDESK
SITE MAP
Forgot adrinistrator password?
-
4 | 5
@ [ emes

If you have forgotten the administrator password, you can reset the
password by clicking the link at the bottom of the page. For further
information, see the next section Resetting the Administrator password.

3. Click Logon.

The Administration page is now updated to let you change the user name
and password, Save/load a configuration or log off Administration.
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Resetting the Administrator password

If you have forgotten the administrator password, do as follows:

1. Contact your supplier for a reset code.
Please report the serial number and IMEI number of the terminal.
You can find the serial number and IMEI number in the Dashboard.

2. Click the link Forgot administrator password? at the bottom of the
ADMINISTRATOR LOGON page (see the previous section).

Thrane & Thrane

SIGNAL: noooooo

RESET ADMINISTRATOR PASSWORD
DASHEDARD I

Reset code:

Reset I Cancel I

PHONE BOOK
MESSAGES

CALLS

SETTINGS
ADMINISTRATION
HELPDESK

SITE MAP

4|

o

| »
[€]pone T [ mntemee

3. Typein the reset code obtained from your supplier and click Reset.
4. Type in the user name Admin and the default password 1234.
5. Click Logon.

For information on how to change the password, see the next section

Changing the administrator password.

134

Administration




Chapter 4: Using the web interface

Changing the administrator password

Do as follows:

1. After entering the Administrator user name and password in the
ADMINISTRATION page, locate the section Change administrator logon.

Thrane & Thrane
SIGNAL: noooooo
Please remember to log off after use
DASHEOARD Change administrator logon
PHONE BOOK User name [
MESSAGES MNew password l—
CALLS Retype new password
SETTINGS Change I @
ADMINISTRATION Configuration = %
y—
Call charges Save configuration to file ﬁl E
eedlandllng Load configuration fram file l— Browse, Lﬂ_édl '_E
ARil0 Administrator logoff qu
Traffic flow filters Logott I _(IC)
5IM Lock -~
User permissions .?
HELPDESK 5
SITE MAP -
y | o
‘a Dane ’7’7’7’7’7 & Internet v

2. Type in the existing user name.
3. Type in the new password and retype it on the next line.

4. Click Change.
At the next logon the new password is required.
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Saving a configuration to a file

If you need to reuse a configuration in another terminal of the same type, you
can save your current configuration to a file, which can then be loaded into
the other terminal.

Do as follows:

1. In the ADMINISTRATION page, under Configuration, click Save.

2. Accept the default destination file name or type in the destination file
name and location.

3. Click OK.

The configuration is now saved to a file. This file is used to load the
configuration into another terminal. See the next section.

Loading a configuration from a file

1. In the ADMINISTRATION page, under Configuration, click Load.
2. Click Browse... to browse to the file you want to import. Then click Open.

3. Click Load.
The new configuration is now loaded into your terminal.

Logging off administration

If you have not entered anything for 30 minutes under ADMINISTRATION, you
are logged off automatically.

To log off manually, click Logoff under Administrator logoff in the
ADMINISTRATION page.
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Call charges

If you know the tariff for your subscribed services, you can enter these tariffs in
the web interface and automatically calculate the charges for your calls and
data sessions.

m KVH Industries does not take responsibility for the correctness of the
estimated charges. This calculation is only a rough estimate of the
charge, based on the tariff entered by the user. Also, the Airtime
Provider may have different methods of calculating the charge.

Do as follows:

1. From the left navigation pane, select
ADMINISTRATION > Call Charges.

()
Thrane & Thrane i)
“—
=
]
SIGNAL: 0oooooo =
o)
v
The billing details from your Inmarsat Service Provider can be entered below. ;
DASHBOARD
()
PHONE BOOK Currency: EUR =] (for display purposes only) =
—
MESSAGES (=)
Standard voice: EUR 0,00 Per minute o
CALLS &
SETTINGS =
3.1 kHz Audi: EUR jo.00 | per minute
ADMINISTRATION
Standard data: EUR 0,00
Call charges andard data per MegaByte (1000 ki)
Log handlii
29 handiing Streaming 32: EUR [0.00 | per minute
Profiles
Traffic flow filters Streaming 64: EUR 0,00 per minute Lo
SIM Lock
streaming 128: EUR 0.0 per minute
User permissions
HELPDESK Streaming 2561 EUR o050 per minute
SITE MAP
Apply Cancel
Disclaimer: Please note that the estimates made on this basis are only indicative and
Thrane & Thrane cannot be held liable for any differences between these and your actual
bill. If you change the currency or the rates, these changes will also be applied to
historical figures, so you may want to save the call log to 2 separate file to keep track of
historical data.
4| | _’lJ
&] Dane [ [ [ [ |4 mtemet v

2. Select the currency from the Currency drop-down list.

3. Enter the tariff for each of the services.
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4. Click Apply.
The entered tariffs are used for estimating the charges for calls and data
sessions. The estimated charge is listed for each call or data session in the
call log. For further information, see Viewing the lists of calls on page 77.

Log handling
1. From the left navigation pane in the ADMINISTRATION page, select Log
Handling.
SIGNAL: [ooooon

DASHEOARD Clear call log? ﬂl
PHONE BOOK Clear total counters? ﬂl
MESSAGES
CALLS
SETTINGS
ADMINISTRATION &

call charges

Log handling
Profiles

Traffic flow filters
SIM Lock

User permissions
HELPDESK

SITE MAP

=

|

| 5
& [T e
2. To clear the Call log, click OK next to Clear call log?.

3. To clear the total counters, click OK next to Clear total counters?.
This will reset the Time connected counters on the Calls page.
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Using profiles

What is a profile?

A profile is a collection of Quality of Service (QoS) settings and other settings
defining the mode in which data is transmitted. For example, a profile is used
to define whether the connection is a Streaming connection or a Standard
connection.

You can select between a number of predefined profiles or define your own
profiles for your data transmission.

If no traffic flow filters are defined, the Primary profile for a user group is used
for all traffic from that user group. See What are traffic flow filters? in the next
section.

For further information on profiles, refer to the 3GPP standard TS 23.107.

Selecting the profiles for a network user group

When you set up a network user group, you select the profiles to use for that
user group. You select a Primary profile and optionally one or more Secondary
profiles.
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For further information on how to select the profiles, see Managing LAN
network users on page 111.
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Defining new profiles

When you define your profiles you can select Subscribed for many of the
settings. If you select Subscribed, the value given in your Airtime subscription

will automatically be used.

m ‘ For TracPhone FB250, the maximum Streaming bit rate is 128 kbps.

To define a new profile, do as follows:

1. From the left navigation pane, select ADMINISTRATION > Profiles.

Thrane & Thrane

SIGNAL: Ooooooo
DASHBOARD

PHONE BOOK
MESSAGES

CALLS

SETTINGS
ADMINISTRATION
call charges

Log handling
Profiles

Traffic flow filters
SIM Lock

User permissions
HELPDESK

SITE MAP

4

Traffic
class

Maximum
bit rate Ul
(kbps}

Maximum
bit rate DI
(kbps)

Guaranteed
bit rate Ul
(kbps}

Guaranteed
bit rate DI
(kbps}

Delivery
rder

Maximum
30U size
(Byte)

SDU error
ratio

Residual bit
errar ratio

Delivery of
erroncous
SDUs

Transfer
delay (ms)

Traffic
handling
priority

standard ing

ing

o) o) 5 el [user defined 1 [user defined =
Backgi d g g 2 2
0 32 54 128 256 o o
0 32 4 128 256 o o
o 32 64 128 256 o o
0 32 54 128 256 o o

Subscribed  Subscribed  Subscribed  Subscribed  Subscribed

Subscribed = Subscribed =

4
4

Subscribed  Subseribed  Subseribed  Subseribed  Subseribed

Subscribed  Subscribed  Subscribed  Subscribed  Subscribed

_Apply | _cancel

[ebsobed =] [subsmmbed =]
|—n |—n
| e B e |

]

[ [ [ [ mntemet

2. Inone of the User defined columns, fillin the top field with the name of

your profile.
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3. In the Traffic class row of your new profile, select a class from the drop-
down list.

m For best performance, choose the right traffic class for your
application. In general, Standard data (Background) is best
suited for TCP/IP applications, and Streaming data is best
suited for UDP traffic, e.g. live video or audio.

You may select one of the following:

» Conversational is real-time two-way conversation. It is primarily used
for voice over IP and video conferencing.

» Streaming is real-time one-way communication. It is primarily used for
video and audio.

 Interactive is two-way communication (not real-time). It is used for
communication that is not very delay-sensitive, such as web browsing,
data base retrieval and server access. Examples of machines
interaction with remote equipment are: polling for measurement
records and automatic data base enquiries (tele-machines).

* Background is used for data which is not delay-sensitive, such as E-
mails, SMS, download of databases and reception of measurement
records.
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4. Type in the bit rates in kbps in the following rows:

m ‘ For TracPhone FB250 the maximum allowed bit rate is 128 kbps.

* Maximum bit rate ul (kbps) is the maximum upload bit rate allowed for
this profile.

* Maximum bit rate dl (kbps) is the maximum download bit rate allowed
for this profile.

* Guaranteed bit rate ul (kbps) is the guaranteed upload bit rate needed
for this profile.

* Guaranteed bit rate dl (kbps) is the guaranteed download bit rate
needed for this profile.

m When you click Apply, the bit rate values you typed in may be
rounded off because only certain values are allowed.
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10.

11

12.

In the Delivery order row, select from the scroll list whether or not data
should be delivered in the same order it was sent. Yes means the data
packets are delivered in the same order they were sent.

In the Maximum SDU size (byte) row, type in the maximum allowed packet
size in Bytes (rounded off to nearest 10). The maximum packet size
possible is 1520.

In the Delivery of erroneous SDUs row, select one of the following from the
list:

* Yes means packets are allowed to contain errors. This setting is
suitable for delay-sensitive transmission, because the need for
retransmission is limited. The SDU Error settings in step 8 and step 9
will apply.

* No means packets are not allowed to contain errors, and the SDU Error
setting in step 8 will not be applied. This setting is suitable where
error-free transmission is important and delays are accepted.

* No detect means that errors will not be detected, and the SDU Error
setting in step 8 will not be applied.

If you selected Yes in step 7, select from the SDU error ratio drop-down list
the fraction of a packet allowed to be lost or erroneous.

Select from the Residual bit error ratio drop-down list the undetected bit
error ratio of a packet. If no error detection is requested, Residual bit error
ratio indicates the bit error ratio in the delivered packets.

In the Transfer delay (ms) row, type in the delay in ms. This is the delay
from the time data is received in the terminal until it arrives at the
receiving end.

+ Ifthe Transfer delay is 500 ms, error correction is disabled.

+ Ifthe Transfer delay is 4000 ms, error correction is applied.

In the Traffic handling priority row, select from the drop-down list which
priority this connection should have.

Click Apply.

The new profile is now added, and can be selected from the lists of primary
and secondary profiles when you set up your interfaces.
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Using traffic flow filters

What are traffic flow filters?

When more than one type of traffic is needed, you must use both a primary
and one or more secondary profiles. For the Core network and the terminal to
classify packets received from the external network into the proper profile, you
need a traffic flow filter.

A list of traffic flow filters consists of one to eight packet filters, each identified
by a unique packet filter identifier. A packet filter also has an evaluation
precedence index that is unique within all traffic flow filters associated with
the profiles that share the same PDP (Packet Data Protocol) address.
Information of source, destination, type of service etc. is combined in each
packet filter in the list.

Purpose of the traffic flow filters

The purpose of the traffic flow filters is to assign different priorities to different
types of traffic, in order to optimize performance.

Example: When you are browsing the Internet, a Standard data connection is
normally sufficient. However, to have a video conference you may
need a Streaming connection in order to obtain a direct connection
without interruptions. Your traffic flow filters can define these
priorities, so that your connection automatically switches to
Streaming e.g. when you have a video conference.
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Defining traffic flow filters

To define the traffic flow filters, do as follows:

1. From the left navigation pane, select
ADMINISTRATION > Traffic flow filters.

Eval. Dest. Source

Prec. Profile Source Address Subnet Mask Prot. No. Port Port

Index Range Range
0 streaming 64 17

Hew sntry

2. Click the link New entry.

Type TYRE
F of
.. Service
service *pIIE
Edit Delete

Thrane & Thrane
SIGNAL: uuuuuuu
ENTER ¥ALUES FOR NEW FILTER
DASHBOARD Eval. Prec. Index:
PHONE BODK Profils
MESSAGES Source Address
CALLS Subnet Mask
SETTINGS Prot, Mo,
ADMINISTRATION

Dest. Port Range
call charges

Source Port Range
Log handling

Type of Service
Profiles

Type of Service Mask

apply | Gancel

Traffic flow filters
SIM Lock

User permissions

=
rr—r—
- r—r—
—
ol
ol
—

—

HELPDESK
SITE MAP
4] | B
|&] pone [ [ [ |4 mnkernst
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3. Typein an Evaluation Precedence Index in the Eval.Prec. Index column.

m This field is mandatory. Each filter must have a different
Evaluation Precedence Index.

4. Select the Profile from the scroll list.

The available profiles are the profiles listed in the ADMINISTRATION >
Profiles page.

5. Fillin one or more of the following fields to define the filter.
The allowed ranges appear in hover text when you pass the mouse over
the fields.

¢ Source address + Subnet mask.
¢ Protocol number.

* Destination port range (From and To). Note that Source and
Destination are relative the core network. This means that Destination
is your terminal.

* Source port range (From and To).
* Type of Service + Type of Service mask.

For further information on the principles and parameters of the traffic flow
filters, refer to the 3GPP standards TS27.007 V4.2.0 and TS 23.060 V4.7.0.
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6. Click Apply at the bottom of the page.
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Setting up user permissions

You can restrict access to parts of the web interface for non-administrator

users.

To set up the user permissions, do as follows:

1. From the left navigation pane, select ADMINISTRATION > User

permissions.
Thrane & Thrane
SIGNAL: uuuuuuu
DASHBOARD ALLOW USERS TO:
PHONE BOOE Upload software & yes © no
MESSAGES Edit phone book ® yes  no
CALLS
Change phaone settings * yes " no
SETTINGS
Change LAM settings
ADMINISTRATION 2 g Qs Wi
call charges Change I1SDN settings @ yes  no
Log handling Change IP handset settings = yes  no
Profiles
Change discrete 1/0 settings = yes  no
Traffic flow filters
) LD Change supplementary services ® yes  na
User permissions Change common settings  yes  no
HELPDESK Change general settings @ yes  no
SITE MAP
Perform self test ® yes no
ALLOW AT COMMANDS ON:
Changes to AT command permissions only take effect after reboot
LAN interface * yes  no
App\yl CEHEE|I
=
4| | »

@ LI ws

2. For each item under ALLOW USERS TO:, select
* yesto allow access or

* no to block access to the settings.
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3. Under ALLOW AT COMMANDS ON:, select
* yes to allow the use of AT commands on the LAN interface, or
* no to block the use of AT commands on the LAN interface.
Note that this setting does not take effect until the terminal is restarted.

4. Click Apply.

The settings to which access is denied are now greyed out for the non-
Administrator user.
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Help desk and diagnostic report

Accessing the Help desk

If you need help with airtime-related issues you may call the Help desk. By
default, the Help desk is the phone number for your Airtime Provider, if it is
available on the SIM card.

Select HELP DESK from the left navigation pane.

Thrane & Thrane

SIGNAL: 1000000

SUPPORT:

DASHBOARD . .
For help, please contact: Flease enter support information here

PHONE BOOK

MESSAGES ) ) . =
Generate diagnostic report to file? Generate repart I
CALLS
SETTINGS
ADMINISTRATION
HELPDESK
Event list

Event log

self test

STITF MAP -
4 | 5

& pone [T T T T [@menet 4

If the Help desk number is available on the SIM card, the number is displayed
as a link. To change the number, click the link, change the number and click

Apply.

If you need help with terminal- or antenna-related issues you should call your
local distributor.
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Generating a diagnostic report
If you want to generate a diagnostic report, do as follows:

1. Click Generate report from the HELP DESK page.

In some browsers the file may open directly in your browser. If it does,
choose File > Save As to save the file.

2. Choose a location for the file and save it.

The diagnostic report contains relevant information for troubleshooting.
Please enclose this file when you are reporting an error.
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Event logging and self test

Viewing the Event list or the Event log

Overview

When an event is registered, the web interface shows an eventicon A in

the icon bar as long as the event is active.

The Event list only shows events that are currently active, whereas the Event
log shows the history of events that have occurred.

Event list

To view the event list, click the eventicon from the icon bar at the top of the
web interface, or select HELPDESK > Event list from the left navigation pane.

SIGNAL: 1nanono A

DASHBOARD
PHONE BOOK
MESSAGES

CALLS

SETTINGS
ADMINISTRATION
HELPDESK

Event list

Event log

Self test

SITE MAP

4|

First reported
Fri Jun 15 12:42:50 2007
Fri Jun 15 12:02:20 2007

FriJum 15 11:52:24 2007

i) Unit  Sewverity Text
00101-0 Terminal ERROR System data damaged

00104-0 Terminal ERROR Systemn data damaged

ttenna cable loss calibration
led

03100-0 Terminal ERROR AN

| 3

]

11 | [@wem y

The Event list page shows a detailed list of active events including the time of
the first occurrence, ID and severity of the event message, and a short text
describing the error. For more information on the event messages, refer to

Event messages on page 167.
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Event log

To view the Event log, select HELPDESK > Event log from the left navigation
pane.

The Event log shows the same information as the Event list, but also includes
events that occurred in the past and are no longer active. Additionally, it lists
events of informational character, describing normal phases of operation for
the terminal.

Self test

The Self test performs system test on the TracPhone system, similar to the tests
that are performed during the Power On Self Test (POST).

m The terminal will reboot when performing the self test. All %
ongoing calls or data sessions will be terminated. T
o
=
To activate a Self test, do as follows: =
S
1. Select HELPDESK > Self test. £
Thrane & Thrane 2
SIGNAL: Q00oooo
warning! The terminal will reboot to perform the self test, Rebooting the terminal will
DASHBOARD terminate all existing connections.
PHONE BOOK Self test
MESSAGES
CALLS
SETTINGS
ADMINISTRATION
HELPDESK
Event list
Event log
Self test
SITE MAP
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2. Click Self test.

3. Click OK in the Warning dialog.
The terminal now performs a self test and resets the terminal.

What’s next?

This chapter has explained how to use the web interface for setup and use of
the system. You should now be able to set up the system, check status, read
and send SMS messages, use the phone book and much more.

The following chapter, Troubleshooting, provides guidelines for
troubleshooting, an overview of the different means of status signalling, and a
list of available spare parts and accessories.
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Chapter 5

Troubleshooting

In this chapter

This chapter gives guidelines for troubleshooting and provides an overview of
the different means of status signaling, It also lists available spare parts and
accessories.

Getting support

Overview

If this manual does not provide the remedies to solve your problem, you may
want to contact your Airtime Provider or your local distributor.

Airtime support

If you need assistance from your Airtime Provider, please call the help desk.
To see the help desk number, enter the web interface of your terminal and
select HELP DESK. This help desk number is either taken from the SIM card or
entered manually. If no number is available under HELP DESK, check your
Airtime subscription for a contact number.
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System support

If you need assistance with problems caused by the terminal or antenna,
please call a distributor in your area.

You can find a certified dealer or distributor near you by visiting KVH's web
site: www.kvh.com/wheretogetservice.
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Uploading software

Viewing software version status

To view the version of the embedded software in the terminal, connect a
computer, enter the web interface and see the Software version field in the
Dashboard.

Uploading software using the web interface

You can upload software from the web interface.

If you have an Administrator user name and password you do not need to
insert a SIM card nor to enter the PIN to be able to upload software.

For further information, see Uploading software on page 126.
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Part numbers

Spare parts, TracPhone FB500

Antenna spare parts
Item Part number
HPA module 34-562124671
ATB/LNA module 34-588126533A
GPS module 34-560124765
Cables
Item Part number
Antenna cable, 30 m 34-126525-A

DC cable

34-37125999-A

LAN cable, 2 m

34-37203213-A

Part numbers
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Spare parts, TracPhone FB250

Cables

Item

Part number

Antenna cable, 25 m

34-204567-025

DC cable

34-37125999-A

LAN cable, 2 m

34-37203213-A

Options and accessories

Item

Part number

Basic cable support kit?

34-673738A

Extended cable support kit

34-3738A-940

TracPhone FleetBroadband IP Handset and 34-3670A
Cradle®

TracPhone FleetBroadband IP Handset 34-403672A
TracPhone FleetBroadband IP Cradle 34-403674A
Power supply 28VDC/25AP 34-4665

a. Includedin the basic package for both TracPhone FB500 and

TracPhone FB250.
b. Included in the basic package for FB500.
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Troubleshooting guide

The below table provides information on some of the problems that might
occur, including possible causes and remedies to solve the problems.

Problem

Possible Cause

Remedy

No signal or
weak signal
from the BGAN

The view to the
satellite is blocked.

Make sure the antenna has a
clear view in all directions. See
the installation manual for

satellite. details.
The antenna cable | Check that both ends of the cable
is not properly are connected properly according
connected. to the guidelines in the
Installation manual.
Also check that no connectors are
damaged.
The system is set Enter the web interface. Select
up to use one SETTINGS > Satellite selection.
specific satellite, Select Auto and click Apply.
but t.he system s The system will now search for
outside coverage o
. the satellite with the strongest
from that satellite. .
signal and attempt to connect.
No The Radio silence If the Radio silence function
transmissionon | functionis should not be activated,
the BGAN activated from an deactivate it from the external
network is external device device.
possible. connected to the

1/0 interface of the
terminal.
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Problem

Possible Cause

Remedy

Connection to
the Internet

Your network user
group does not

The Administrator can access and
change network user groups in

cannot be allow Internet the built-in web interface of the
established. access. terminal.

256 kbps The elevation Availability of 256 kbps Streaming
Streaming does | angle to the can only be guaranteed in areas
not work satellite is too low. | with over 15 degrees elevation.
128 kbps The elevation Availability of 128 kbps Streaming
Streaming does | angle to the on TracPhone FB250 can only be
not work on satellite is too low. | guaranteed in areas with over 15
FB250 degrees elevation.

The web The browser is For Microsoft Internet Explorer,
interface configuredtousea | select Tools > Internet Options >
cannot be proxy server. Connections > LAN Settings and
accessed. uncheck Use a proxy server for

your LAN.

You have entered a
wrong IP address.

Check the IP address and re-enter
it. If you do not have the correct
IP address, you can set the IP
address temporarily to the default
address (192.168.0.1) by pressing
the Reset button. See Function of
the Reset button on page 181.

You are connected
using VPN

Close down your VPN connection.
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Problem

Possible Cause

Remedy

A Phone/Fax
connection
cannot be
established.

The cable is not

properly
connected.

Connect the cable.

The cable type or
connector type is
not correct.

For information on the correct
type of connector and cable, refer
to the installation manual.

Incoming calls:
The call type used
for the callis not
selectedin the web
interface.

Make sure the call type used for
calls to the terminal is selected in
the web interface. Access the web
interface and select SETTINGS >
Phone/Fax. Then, for each of the
two ports, select the call type for
incoming calls.

FB250: If you are
located in a low
elevation area
(<20°), 3.1kHz
Audio is not
supported.

Use Standard voice in stead of
3.1kHz Audio when you are
located in areas with low
elevation (< 20°).
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Problem Possible Cause Remedy
An ISDN The cable is not Connect the cable.
connection properly
cannot be connected.
established
You have Connect the cable to the interface

connected to the
LAN interface.

marked ISDN.

The cable type or
connector type is
not correct.

For information on the correct
type of connector and cable, refer
to the installation manual.

Incoming phone
calls: The call type
used for the callis
not selected in the
web interface.

Make sure the call type used for
calls to the terminal is selected in
the web interface. Access the web
interface and select SETTINGS >
ISDN. Then select the call type for
incoming calls.

FB250: The ISDN
service is not
supported.

Use another service. You may still
use the ISDN interface on the
terminal, but only Standard voice
and 3.1 kHz Audio are available.

No phones are
ringing on
incoming calls

The Mute function
is activated from
an external device
connected to the
/0 interface of the
terminal.

If the Mute function should not be
activated, deactivate it from the
external device.
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Problem Possible Cause Remedy
A LAN The cable is not Connect the cable.
connection properly
cannot be connected.
established.

The cable type or
connector type is
not correct.

For information on the correct
type of connector and cable, refer
to the installation manual.

An IP handset
connection
cannot be
established.

The cable is not

properly
connected.

Connect the cable.

You have
connected to the
ISDN interface.

Remove the cable and connect to
one of the LAN connectors in
stead.

There is no power
(PoE) in the LAN
interface. The
reason may be that
there is not
enough power to
supply PoE for the
LAN interface.

Check that the input voltage is
within the specified range
(10.5-32VDC; 14 A-5.5A).

Check that you do not have too
many power-consuming devices
connected. The maximum
available output power on the
LAN (PoE) interface is 32 W if you
are using a 12 V supply and 64 W
if you are using a 24 V supply.

If possible, disconnect other
connected devices.
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Problem

Possible Cause

Remedy

The
Administrator
password does
not work.

Someone has
changed the
Administrator
password.

If the correct password is not
found, you have to reset the
password.

Contact your supplier for a reset
code. You must provide the serial
number and IMEI number of the
terminal.

Then enter the web interface and
reset the password as described
in: Resetting the Administrator
password on page 134.
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Status signaling

Overview
There are many ways of troubleshooting if an error occurs. The terminal has
different means of status signaling, to help you find the cause of a problem:

* Indicators.
¢ Event messages.

¢ Event log.

Indicators, event messages and logs are described in the following sections.
Light indicators

Overview

The terminal has a number of LEDs, placed in the panel at the top of the
terminal:

* agreen Power indicator,
* agreen/red/ orange Terminal indicator,

* agreen/red/orange Antenna indicator,
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* agreen Message indicator and

* 3 LANindicators for each LAN interface, showing Activity (Green),
Link/Speed (Green/Yellow) and PoE (Green/Red).

Power Terminal Antenna Message LAN1 LAN2 LAN3 LAN4

Activity I I

- Link/Speed Il I NN S

PoE I I S
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General status indicator functions

Power Terminal

Power indicator

Antenna  Message

Behavior

Meaning

Green

Power OK.

Flashing green

The terminal is powering up.

Flashing orange

The terminal is closing down.

Off

No power.

Terminal indicator

Behavior

Meaning

Steady green

Ready. BGAN registration completed.

Flashing green

Please wait - process in progress.
BGAN registration ongoing.

Orange

Warning - temporary malfunction. User action is
required.
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Behavior

Meaning

Red

Critical error.

Check the event log. If the problem is in the
TracPhone system and you cannot solve it, contact
your distributor and return the unit for repair if
necessary.

Antenna indicator

Behavior

Meaning

Steady green

Tracking. The antenna is ready for use.

Flashing green

Please wait - process in progress.
Slow flashing: The antenna is starting up

Rapid flashing: Sky scan

Orange Warning - temporary malfunction. User action is
required.
Red Critical error.

Check the event log. If the problem is in the
TracPhone system and you cannot solve it, contact
your distributor and return the unit for repair if
necessary.

Message indicator

Behavior

Meaning

Flashing green

A new SMS message has arrived.

Off

No new messages, or the unit is off.

Status signaling 165
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LAN indicator functions

LAN1 LAN2 LAN3 LAN4

Activity I I

Link/Speed N NN NN

PoE N . .
Activity indicator
Behavior Meaning
Flashing green The LAN port is active.

Link/Speed indicator

Behavior Meaning
Green Link speed is 100 Mbps.
Yellow Link speed is 10 Mbps.

Off The link is down.

PoE indicator

Behavior Meaning
Green The terminal is supplying power to the LAN port.
Red The connected device requires more power than

the terminal can supply to the LAN port.

off The terminal is not supplying power to the port.
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Event messages

Display of event messages

The terminal can detect events during POST (Power On Self Test) or CM
(Continuous Monitoring). When the terminal detects an event that requires
your action, it issues an event message.

When your terminal issues an event
message, the Terminal indicator or Power Terminal Antenna Message
the Antenna indicator in the LED
panel on top of the terminal signals
the event, according to the tables
Terminal indicator and Antenna
indicatorin the previous section.

You can see the active event messages in the web interface by clicking the
warning symbol in the icon bar at the top in the web interface.

All events are logged in the event log. For information on the event log, see
Viewing the Event list or the Event log on page 150.
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List of events
The following list explains the events that may show in the web interface of the
terminal.
1D Event Text Explanation Remedy
00100to | System data Important system Do not use the
00199 damaged data is damaged terminal. Contact
your distributor.
00210to | SIM module The SIM interface Contact your
00219 error on the terminal distributor.
cannot be used.
00240to | Temperature The terminalis in Do not use the
00249 Sensor error danger of terminal. Contact
overheating. your distributor.
00260 System error The terminal cannot | Contact your
to 00269 communicateonthe | distributor.
satellite network.
00270to | Voice module Voice services Contact your
00279 error cannot be accessed | distributor.
by the terminal
00280 Ethernet The Ethernet Contact your
to module error interface on the distributor.
00289 terminal cannot be
used.
168 Status signaling
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D Event Text Explanation Remedy
00300 GPS module The GPS module is Contact your
to error out of function. The | distributor.
00309 terminal cannot
obtain a valid GPS
position.
00330to | ISDN failure The ISDN interface Contact your
00339 on the terminal distributor.
cannot be used.
00340to | 2-wire failure | The Phone/Fax Contact your
00349 interface of the distributor.
terminal cannot be
used.
00350 AD9864 Internal errorin the | Contact your
to 00359 | calibration receiving part of the | distributor if the
data error terminal. problem persists.
00360 No antenna The terminal cannot L Chslckbar][tenna
t0 00369 | found communicate with ca e. etween
terminal and
the antenna.
antenna.
2. Reboot the
terminal.
01000to | Low Low ambient Move the terminal
01009 temperature temperature is to a warmer
warning causing the location.

performance of the
terminal to be
degraded or halted.

For information on
ambient
temperature limits,
see the installation
manual.

Status signaling
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ID Event Text Explanation Remedy
01100to | High High ambient Move the terminal
01109 temperature temperature is to a cooler location.

warning causing the For information on
performance of the .
. ambient
terminal to be ..
degraded or halted temperature limits,
* | see theinstallation
manual.
01110 to Temperature Critically high Move the terminal
01119 too high temperature is to a cooler location.
(critical) caus!ng the For information on
terminal to shut .
ambient
down. .
temperature limits,
see the installation
manual.
Contact your
distributor if the
problem persists.
01300to | No GPS fix The GPS receiver Make sure the view
01309 has notyetachieved | to the GPS satellites
position fix. is not blocked.
Note that in some
cases it may take up
to 10 minutes to
obtain GPS fix.
01400to | Satellite The TracPhone Make sure the
01409 signal lost system no longer antenna has a clear

receives a signal
from the satellite.

view to the satellite.
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D Event Text Explanation Remedy
01500to | SIM card No SIM card is Insert SIM card.
01509 missing Sleottected in the SIM I the SIM card is

) alreadyinserted, try
removing and
reinserting it.

01600to | SOS calls only | The SIM cardis not | Enter the PIN and
01609 accepted by the wait for network
network. Only approval. If the
emergency calls are | problem persists,
allowed. contact your Airtime
Provider.
01700to | Registration The TracPhone If the problem
01709 for voice system has not yet persists, contact
failed been allowed to your Airtime
register for voice Provider.
services (Circuit
Switched).
01800to | Registration The TracPhone If the problem
01809 for data system has not yet persists, contact
failed been allowed to your Airtime

register for data
services (Packet
Switched).

Provider.

Status signaling
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ID Event Text Explanation Remedy
02000 Satellite The signal from the | Check the line of
to signal weak satellite is weak. sight to the satellite.
02009 Be aware that

window glass may
reduce the signal
level.
Check that the
antenna is pointed
according to the
position data.
Adjust the position
to the highest
possible signal
strength.
02100to | Ciphering Off The network has Do not transmit data
02109 turned ciphering that requires
off. ciphering.
02200to | Ethernet data Ethernet data See the call log for
02209 session failed | sessioncouldnothe | the cause of the
established. error. Refer to
Viewing the lists of
calls on page 77.
If the problem
persists, contact
your distributor.
02900 Network failed | The TracPhone Restart the
t0 02909 | authentication | system does not TracPhone system.
accept the network
as a valid BGAN tf th'e problem
network persists, contact
’ your distributor.
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1D Event Text Explanation Remedy
03500 2-wire 2-wire calibration
t0 03509 | calibration failed on the
failure Phone/Fax
interface, because
of:
1. Common mode 1. Check the wires
balance error. to your phone or
fax.

2. The hook is off. 2. Putthe hook on.

3. Wires are 3. Check the wires.
shorted to each
other or shorted

to ground.
03600 2-wire The Phone/Fax
to 03609 | operational interface fails to
failure operate, for one of
the following
reasons:

1. Ground shorted. | 1. Check the wires.
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2. Power overload. | 2. Wait until the
eventis cleared;
then try again.

3. Temperature 3. Wait until the
overload. eventis cleared;
then try again.

Status signaling 173



Chapter 5: Troubleshooting

ID Event Text Explanation Remedy
08002 One or more The power supplyto | Ensure a stable
ports has PoE the terminal has power supply to the
disabled due dropped critically. terminal.
to power PoE is disabled to
limitations ensure enough
power to the
antenna.
08008 Antenna Theantennavoltage | Check the cable to
exceeds is either too high or | the antenna.
1 .
zﬁrzzgild too low Contact your
distributor if the
problem persists.
08009 Power Hold-up The power supplyto | Ensure a stable
- the terminal | theterminal has power supply to the
can no longer dropped for too terminal.
power the long. The antenna
antenna does not have
enough power to
function.
0800A Reduce PoE - Theinput voltage to | Ensure a stable

the terminal
reduces PoE
with 30W

the terminal is too
low. The terminal
will lower PoE
power from 60 W to
30 W.

power supply to the
terminal.
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1D Event Text Explanation Remedy
0800B PoE Overvoltage is Do not use the
Overvoltage detected in the terminal.
protection is terminal. The
) . . Contact your
activated terminal will be .
. distributor.
shut down in 10
minutes.

0800D Antenna Overvoltage is Do not use the
Overvoltage detected in the terminal.
protection is antenna. The

) . . Contact your
activated terminal will be N
. distributor.
shut down in 10
minutes.

08010 Undervoltage The input voltage Ensure a stable
has been has dropped below | power supply to the
detected an acceptable level. | terminal.

The terminal will be
shut down in 10
seconds if the
situation persists.

0801B Lost Communication Contact your
connection to with the GPS distributor if the
the GPS receiver in the warning persists.
receiver antenna is lost.

0801D Uploading New firmware is Contact your
firmware to being uploaded to distributor if the
antenna the antenna. Event is not cleared

The Event will be
cleared when

upload has finished.

within 5 minutes.

Status signaling
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1D Event Text Explanation Remedy
0802C Firmware The terminal was Contact your
update still unable to upload distributor.
fails after new firmware to the
several antenna.
retries
0802D Firmware The terminal was Reboot the
update failed unable to upload terminal.
new firmware to the
antenna. Cpn{act your
distributor if the
problem persists.
0802E Firmware is The firmware in the | Update the terminal
older than antenna is newer software.
current than expected by
antenna the terminal.
version
0802F Antenna main Antenna failed to Reboot the
image could start up normally. terminal.
not be loaded
Contact your
distributor if the
problem persists.
08030 Antenna could Antenna failed to Reboot the
not enter main | startup normally. terminal.

application
mode

Contact your
distributor if the
problem persists.
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D Event Text Explanation Remedy
08031 Failed to Antenna failed to Reboot the
enter normal start up normally. terminal.
operation Contact your
distributor if the
problem persists.
08032 Firmware image | Thefirmwareinthe | Updatethe terminal
version lower antenna is newer software.
than active than expected by
antenna the terminal.
version
08033 Firmware image | The antenna Contact your
doesn't hardware versionis | distributor.
support not supported by
antenna the terminal.
hardware
08034 Antenna failed | New firmware was Reboot the
to exit Flash successfully terminal. Contact
Manager. Power | uploaded to the your distributor if
cycle needed antenna but the the problem
antenna failed to persists.
start normally with
the new firmware.
08035 Unable to open | Therewasan error | Reboot the

port for HPA
burst
monitoring

communicating with
the antenna.

terminal. Contact
your distributor if
the problem
persists.

Status signaling

177

o
=
K=
o
)
<
(%]
i
=
S
o
2
'_




Chapter 5: Troubleshooting

ID

Event Text

Explanation

Remedy

08036

Radio silence
is activated

The Radio silence
function is
activated. No
transmission is
allowed.

If the Radio silence
function should not
be active, enter the
web interface and
select SETTINGS >
Discrete I/0. Then
uncheck the
Enabled box for
Radio silence.
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Logging of events

Diagnostic report

When contacting KVH Industries for support, please include a diagnostic

report.
The diagnostic report contains information relevant for the service personnel

during troubleshooting.

To generate the diagnostic report, access the web interface and select
HELPDESK. Then click Generate report.

Event log

The event log holds information of events registered in the terminal or
antenna. The same events are also indicated in the Antenna and Terminal
LEDs on the terminal LED panel.

The log includes the time of the occurrence, a short description, location of the
error etc. This information can help troubleshooting errors in the system. You
can see the event log in the web interface. For further information, see
Viewing the Event list or the Event log on page 150.
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Reset button

How to access the Reset button

The terminal has a Reset button placed next to the SIM slot behind the SIM
cover. The functions of this button is described in the next section.

To press the Reset button, use a pointed device.
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Function of the Reset button

The Reset button on the terminal has the following functions:

Action

Function

With the terminal
running, press the
Reset button
normally.

The terminal IP address and IP netmask are
temporarily set to the default value (default IP
address: 192.168.0.1).

With this function, even if the IP address has been
changed and you do not remember the new IP
address, you can still access the web interface and
see your current configuration. The default value is
not saved in the configuration, but is only valid until
next reboot.

With the terminal
running, press
and hold the Reset
button for 30
seconds, until the
Power indicator
on the terminal is
flashing orange.

The terminal restores factory settings and reboots the
system.

While the terminal
is booting, press
and hold the Reset
button.

For service use only!
The bootloader initiates software upload.

Refer to the installation manual for details.
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Conformity

TracPhone FB500

CE (R&TTE)

The TracPhone FB500 is CE certified (R&TTE directive) as stated in the
“Declaration of Conformity with R&TTE Directive”, enclosed in copy on the next

page.
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Thrane & Thrane

Thrane & Thrane A/S

Declaration of Conformity with R&TTE Directive

The undersigned of this letter declares that the following equipment complies with the
specifications of EC directive 1999/5/EC concerning Radio & Telecommunications Terminal
Equipment.

Equipment included in this declaration

TT-3740A SAILOR 500 FleetBroadband System:

TT-3052A SAILOR 500 FleetBroadband Antenna PN = 403052A
TT-3738A SAILOR FleetBroadband Terminal PN = 403738A

Equipment Applicability

The SAILOR 500 FleetBroadband is a system that provides voice, fax or high speed data
communication through the Inmarsat satellite service world wide between a ship and any
destination in the world.

Declaration

The safety requirement with respect to the LVD directive 73/23/EC is met by conforming to the
harmonized EU standard EN 60950. The protection requirement with respect to the EMC
directive 89/336/EC is met by conforming to the harmonized EU standard EN 60945. Effective
use of frequency spectrum is met by a conformity assessment by the National Telecom
Agency, Denmark, Notified Body No. 0170, on the basis of the harmonized EU standard ETSI
EN 301 444. )

Manufacturer
Thrane & Thrane A/S Lundtoftegardsvej 93D, DK-2800 Kgs. Lyngby, Denmark
Porsvej 2, DK-9200 Aalborg SV, Denmark

Place and Date
Kgs. Lyngby, 15. November 2007

C

Lars Thrane, President
Thrane & Thrane A/S

Doc. no. 99-126558.A - Page: 1 of 1

Thrane & Thrane A/S - Lundtaftegaardsvej 93 D + DX-2800 Kgs. Lyngby + Denmark
T+4539558800 « F+453955 8888 - info@thrane.com » wvww.thrane.com
Bank: Danske Bank - Comp.reg.: 6572 46 18 + VAT: DK-20 64 64 46
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TracPhone FB250

CE (R&TTE)

The TracPhone FB250 is CE certified (R&TTE directive) as stated in
“Declaration of Conformity with R&TTE Directive”, enclosed in copy on the next

page.

>
A=
(=
=
o
2
(=)
o
(]

TracPhone FB250 185



Thrane & Thrane

Thrane & Thrane A/S

Declaration of Conformity with R&TTE Directive

The undersigned of this letter declares that the following equipment complies with the
specifications of EC directive 1999/5/EC concerning Radio & Telecommunications Terminal
Equipment.

Equipment included in this declaration

TT-3742A SAILOR 250 FleetBroadband System:

TT-3050A SAILOR 250 FleetBroadband Antenna PN = 403050A
TT-3738A SAILOR FleetBroadband Terminal PN = 403738A

Equipment Applicability

The SAILOR 250 FleetBroadband is a system that provides voice, fax or high speed data
communication through the Inmarsat satellite service world wide between a ship and any
destination in the world.

Declaration

The safety requirement with respect to the LVD directive 73/23/EC is met by conforming to the
harmonized EU standard EN 60950. The protection requirement with respect to the EMC
directive 89/336/EC is met by conforming to the harmonized EU standard EN 60945. Effective
use of frequency spectrum is met by a conformity assessment by the National Telecom
Agency, Denmark, Notified Body No. 0170, on the basis of the harmonized EU standard ETSI
EN 301 444.

Manufacturer
Thrane & Thrane A/S Lundtoftegardsvej 93D, DK-2800 Kgs. Lyngby, Denmark
Porsvej 2, DK-9200 Aalborg SV, Denmark

Place and Date
Kgs. Lyngby, 22. November 2007
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Walther Thygesen/ CEO
Thrane & Thrane A/S
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Access Point Name. The Access Point Name is used by the
terminal operator to establish the connection to the required
destination network.

Broadband Global Area Network. A satellite network based on
geostationary satellites, delivering data rates of up to 492 kbps to
virtually any part of the earth, with full UMTS (3G) compatibility.

Conformitée Européenne. This term signifies that a CE certified
product conforms to European health, environmental, and safety
regulations. In short, it makes the product legal to be sold in the
European Union.

Context Identifier
Continuous Monitoring

Circuit-Switched. Circuit-switched networks require dedicated
point-to-point connections during calls.

Dynamic Host Configuration Protocol. A protocol for assigning
dynamic IP addresses to devices on a network. With dynamic
addressing, a device can have a different IP address every time it
connects to the network.

Domain Name System. A system translating server names (URLs)
to server addresses.
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G

Geostationary

GPRS

GPS

HPA

/0

IMEI

IP

ISDN

kbps

LAN

Placed in a fixed position relative to a point on the surface of the
earth.

General Packet Radio Service. A standard for wireless
communications which runs at speeds up to 115 kbps, compared
with current GSM (Global System for Mobile Communications)

systems’ 9.6 kbps.

Global Positioning System

High Power Amplifier

Input/Output

International Mobile Equipment Identity. A unique number
identifying your terminal

Internet Protocol
Integrated Services Digital Network. A circuit-switched telephone
network system, designed to allow digital transmission of voice

and data over ordinary telephone copper wires, resulting in
higher quality and speed than are available with analog.

kilobits per second

Local Area Network

188



Glossary

LED

MAC

MSN

NAT

PDP

PIN

PoE

POR

POST

PS

Light Emitting Diode
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Media Access Control.

Multiple Subscriber Numbering. In most pieces of ISDN
equipment you can program multiple subscriber numbers. The
number programmed into the equipment should be the dial-in
number that you wish that piece of equipment to answer.

Network Address Translation. An Internet standard that enables a
local-area network to use one set of IP addresses for internal
traffic and a second set of addresses for external traffic. A NAT
module makes all necessary address translations.

Packet Data Protocol. A network protocol used by external packet
data networks that communicate with a GPRS network.

Personal Identification Number. A code number used to provide
access to a system that has restricted access.

Power over Ethernet
Pacific Ocean Region

Power On Self Test. A test sequence that runs every time the
system is powered up or reset.

Packet-Switched. Packet-switched networks move data in
separate, small blocks (packets) based on the destination address
in each packet.
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PUK

QoS

RDI

RF

SAS

SDU

SIM

SMS

Streaming

PIN Unblocking Key. An eight-digit code used to unblock a SIM
card after three incorrect PINs have been entered. The PUK code
is supplied with the SIM card.

Quality of Service

Restricted Digital Information

Radio Frequency. Electromagnetic wave frequencies between
about 3 kilohertz and about 300 gigahertz including the
frequencies used for communications signals (radio, television,
cell-phone and satellite transmissions) or radar signals.

Satellite Access Station. The gateway between the satellites and
the worldwide networks such as Internet, telephone network,
cellular network etc.

Service Data Unit. Also known as a data packet.

Subscriber Identity Module.The SIM provides secure storing of the
key identifying a mobile phone service subscriber but also
subscription information, preferences and storage of text
messages.

Short Messaging Service

A technique for transferring data - such as audio or video clips -
so that it is processed as a continuous stream. With a Streaming
connection you are charged by the minute, like for a telephone
connection.
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TCP

uDI

VPN

Transmission Control Protocol. One of the core protocols of the
Internet protocol suite. TCP provides reliable, in-order delivery of
a stream of bytes, making it suitable for applications like file
transfer and e-mail.
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Unrestricted Digital Information

Virtual Private Network. A network that is constructed by using
public wires to connect nodes. You can create networks using the
Internet for transporting data, using security mechanisms so that
only authorized users can access the network.
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2-wire interface
local numbers, 45
setting call type, 91

A

administration settings, 133
analog phone
local numbers, 45
antenna
viewing properties, 86
viewing status, 66
viewing type, 66
APN, common setting, 95
audio quality, 39

barring calls, 99
BGAN
connecting to, 30
coverage, 12
services, 14
system overview, 13
browser settings
for web interface, 58

C

call log, 76

call type, 39
setting for IP handsets, 108
setting for ISDN, 92
setting for Phone/Fax interface, 91

calls
barring, 99
closed user group, 102
forwarding, 98
holding, 48
line identification, 101
local, 46
making or receiving, 42
missed, received, outgoing, 77
redial, 45
to the terminal, 44
transferring, 49
viewing ongoing, 70
waiting indication, 47, 100
CE compliance, 183
clearing logs, 138
clearing usage counter, 138
closed user group, 102
common network settings, 95
computer, connecting to LAN, 25
configuration
exporting to file, 136
importing from file, 136
ISDN, 92
LAN, 87
conformity, 183
connecting to the BGAN network, 30
connector panel, 20
contact information, 153
coverage
Inmarsat BGAN system, 12

D
dashboard, 65
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data

profiles, 139

traffic flow filters, 143
data sessions

viewing ongoing, 70
Declarations of Conformity, 184, 186
dialing prefixes, 46
document number

installation manual, vii

IP handset manual, vii

E

Ethernet interface

setting up, 87
events

in LED panel, 167

list of active, 150
exporting configuration, 136

F

fax, sending or receiving, 50
features overview, 3
forwarding calls, 98

H

help desk number, 148
changing in web interface, 148
holding a call, 48

ignition function, 22
IMEI number, 66
importing configuration, 136

Inbox for SMS messages

replying, forwarding or deleting, 83

indicator functions, 163
installation manual
document number, vii
interfaces and services
combinations, 17
internal calls, 46
Internet connection, 25
IP address
external, setting up, 116
for connected device, 119
for web interface, 60
local, setting up, 88
local, viewing, 66
IP handset
BGAN features, 36
connecting, 24
description, 9
entering PIN, 26
local numbers, 45
manual, vii
part number, 156
setting call type, 108
setting up, 104
starting up, 24
ISDN interface
local numbers, 45
setting up, 92

L

LAN
connecting a computer, 25
managing network users, 111
setting up interface, 87
L-Band interface
enabling or disabling, 86
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LED functions, 163

light indicator functions, 163
limitations in services, 16
line identification, 101

local numbers assigned, 45
local phone call, 46

logs, clearing, 138

M

MAC address, 66
matrix of services and interfaces, 17
messages
configuring outgoing, 84
forwarding, 83
opening in web interface, 83
receiving in web interface, 82
replying, 83
sending, 81
microwave radiation, iii
mobile numbers
viewing and editing, 75

navigation in web interface, 62
network management, 111
network terms

definitions, 124

0

Outbox for SMS messages
resending or deleting messages, 80

P

phone
local call, 46
making calls, 42
phone book, 71
adding number, 74
deleting all entries, 74
deleting an entry, 74
modifying an entry, 74
phone numbers for terminal, 75
Phone/Fax interface
local numbers, 45
setting call type, 91
PIN
administration PIN, 133
entering, 26
entering in web interface, 63
entering with a phone, 26
entering with IP handset, 26
port forwarding, 89
powering the terminal, 21
prefixes, special-purpose, 46
profiles for data transmission, 139
properties
antenna, 86
system, 66
Proxy server, disabling, 58
PUK code, 27, 29, 63

Q

quality of voice, 39
Quick dial, 42

R

radiation, iii
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redial, 45
registering on the BGAN network, 30
remote on/off, 22

S

safety summary, iii
satellite
selecting, 131
view selected, 66
sent messages
resending, forwarding or deleting, 81
viewing status, 81
serial number, 66
services
limitations, 16
supplementary, 92
supported by BGAN, 14
services and interfaces
combinations, 17
Short dial, 42
show number, 101
SIM lock, 16
SMS in web interface
forwarding, 83
opening, 83
receiving, 82
replying to, 83
sending, 81
SMS service number, 85
software
uploading, 126
viewing version, 66
spare parts, 155
Standard data, 52
activating, 54, 69
definition, 52

status
methods for signaling, 163
ongoing calls and data sessions, 70
viewing, 65
Streaming data, 52
activating, 53
definition, 52
supplementary services
setting up, 92
supported, 15
using, 47
support
contact information, 153

T

telephone interface

local numbers, 45

setting call type, 91
tools for setting up the terminal, 35
total usage

viewing, 70, 76
traffic flow filters, 143
transferring a call, 49
troubleshooting guide, 157
typography used in this manual, viii

U

uploading software, 126

usage counter, 70, 76
clearing, 138

user interfaces, 35

vV

version of software, 66
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voice mail number
viewing, 85
voice quality, 39
setting for IP handsets, 108
setting for ISDN, 92
setting for Phone/Fax interface, 91

W

waiting calls, 47, 100

web interface
accessing, 57
browser settings, 58
definition, 57
navigating, 62
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